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IINNTTRROODDUUCCTTIIOONN  

Presuming you are familiar with the principles of a modern EFI engine, (if not please review the Introduction, 
in the Scan Tool manual called "Fundamentals of OBD II EFI Engines":) it may be surprising to learn that it is 
possible that these engines can be electronically "tuned." Just as in the "good old days" when (for example) 
adding a modified camshaft required new jets for the carburettor, and changing the springs and weights on 
the distributor advance, this ability still exists, and is necessary, when making changes to an EFI engine. 

One must know what, where and how many changes to make, and no "12 step process" can give anything 
more than just some obvious basics to the "art" of tuning (there are just too many variables and possible 
changes to offer anything specific!).  Contrary to popular belief, most modern EFI engines are pretty well 
tuned from the factory.  Yes, sometimes for emissions compliance, durability, or broad environment use, (to 
insure the vehicle will run well on an Alaskan mountain in a snowstorm, carrying 5 people and luggage, or in 
a drought in Death Valley, California while doing 150 MPH...) the most optimum selections are averaged. 

This is where, by being able to manipulate the tune, in "100% digital precision," the EFILive Tuning Tool can 
take a "good enough" vehicle and make it a great one!  Even when making small changes, like a new 
exhaust or air intake, or even just trying to "tweak" the car to perfection, this ability to electronically modify 
the car's computer (the PCM) is now possible.  All you are doing is (literally) writing new data to a computer - 
just like you edit changes in an email letter.  (The email program knows how to format the data and where to 
send it so your text is correct, and when it is sent, it is understood at the other end.)  Same thing here, the 
EFILive Tuning Tool takes your new data and carefully and securely sends it to the PCM, and the results can 
then be seen at the other end - of the race track! 

The new tune data is stored in the PCM's flash memory (which is why this process is sometimes called 
"reflashing"), and is non-volatile (meaning it's permanently written and can only be changed using special 
reflash process. Not even removing power from the PCM will remove the changes).  This process, which has 
been in use for almost 40 years, has been carefully engineered into the OEM tools, and is also found in 
EFILive.  Of course, 30 or 40 years ago you needed a big computer, a separate flash-chip programmer, a 
soldering iron and an Electronic Engineering Degree to do this.  Today it's literally "plug and play." 

Finally, we can offer three important notes to remember when using the EFILive Tuning Tool.  When making 
changes to a complex operation, first, always have a backup of where you started, next, make small changes 
and confirm the results, and finally, try to only change one process at a time.  Also, remember, the more 
"perfect" you get the tune, the less flexibility your tune will have, so you may need to create an "Alaskan 
mountain” and a “Death Valley" set of tunes.  With EFILive, you can do that; it only takes 30 seconds to swap 
a tune!  Visit the EFILive message boards frequently and soon you will have that perfect tune. 

 

 
EFILive Tuning Resource: http://forum.efilive.com/ 

 

http://forum.efilive.com/
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What is EFILive? 

EFILive is a PC based, OBD II Scan Tool and Tuning Tool that has been designed by EFI (Electronic 
Fuel Injection) tuning experts to be used by anyone who needs to diagnose, monitor and tune high 
performance engines.  

The EFILive Scan Tool provides real time logging of critical engine performance data, including, but not 
limited to, RPM, throttle position, spark advance, knock retard, long and short term fuel trims, fuel 
injector pulse widths and duty cycles, commanded air/fuel ratio and oxygen sensor voltages. 

The EFILive Tuning Tool  can edit calibration data and save the changes to your PCM permanently. 
Over 180 generic and enhanced parameters provide complete coverage of the vehicle’s performance 
data. And over 350 PCM (Powertrain Control Module) calibrations can be edited. 

Using bidirectional controls, the Scan Tool 
will perform diagnostic checks usually found 
only in expensive OEM (Original Equipment 
Manufacturer) scan tools. The Scan Tool can 
perform the cylinder balance test and the 
crank position sensor relearn. Additionally, it 
can control auxiliary systems such as the 
electric fans, air conditioner, idle control, 
evap canister purge and vent solenoids, 
along with many others. 

For dynamometer use, the Scan Tool can 
lock the torque converter clutch and hold the 
automatic transmission in any gear. This 
prevents unwanted and dangerous 
transmission kick downs when performing 
wide-open throttle dynamometer runs. 

The Scan Tool is also a full featured generic scan tool that will log real time generic data, display and 
clear emissions related trouble codes and display the test results of onboard monitoring systems such as 
O2 monitoring and the system readiness tests. As a generic scan tool, EFILive is compatible with almost 
all GM OBD II vehicles. 
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Conventions used in this document 

 
Potential danger 

  
 

 
Important information 

  
 

 
Helpful information 

  
 

 
Menu choices, for example File->Properties 

  
 

A->B A series of actions that should be followed. 
  

 

 
Keyboard shortcuts, for example Alt+Enter 

  
 

[ ] Toolbar icon – image will be the actual toolbar icon. 

  
 

[Name] Name is the caption on a user interface item such as a button or a tab page. 
  

 
$01…$FF Hexadecimal values are displayed, prefixed with a $ symbol. Hexadecimal 

values belong to the base-16 number system. They are commonly used to 
display values from digital computer systems. 

  
 

<install_folder> This means the folder in which you installed EFILive. If you installed EFILive in 
the default folder on C drive then it will be C:\Program Files\EFILive\V7. 

  
 

<data_folder> This means the folder named My Documents\EFILive\V7. 
  

 
{B9999} A calibration identifier. This is similar to a PID from the Scan Tool, (and uses the 

same curly brace notation). However, PIDs and calibration IDs are not related. 
Each calibration has a unique calibration identifier. Please use the identifier to 
refer to calibrations when corresponding with EFILive. 
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Contacting EFILive Support 

Before reporting any problem that you may experience with EFILive, make sure you are using the latest 
version. To determine which version of EFILive you are using, select the following menu option: 
 

 
Help->About 

The latest version may be downloaded from EFILive’s web site www.efilive.com/downloads. If you are 
running the latest version and are still having difficulty, then please contact us at support@efilive.com 

Please include the following information: 

 An email address where you may be contacted. 

 Your FlashScan serial number and firmware date and version. 

 For the most recently connected vehicle: 
o Model year (i.e. 2002). 
o Model (i.e. Corvette). 
o Engine type (i.e. LS1). 

 A brief description of the problem. 

 The actions required to reproduce the problem. 

 Any other information that you believe may be helpful. 
 

 
You can obtain your FlashScan serial number and firmware date using the menu 
option Help->FlashScan Licensing… 

The EFILive Users’ Forum 

EFILive provides a moderated forum where you can post questions or comments for other EFILive 
users. The EFILive user community has many qualified and experienced EFI tuners. 
You can browse the forum here: http://forum.efilive.com/ without registering. 
If you want to post a question or comment then you must register. Registration is free. 

 

http://www.efilive.com/downloads
mailto:support@efilive.com
http://forum.efilive.com/
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RREEQQUUIIRREEMMEENNTTSS  

PC/Laptop 

Configuration Recommended Minimum
1 

CPU type Pentium class CPU (Includes 
AMD and Cyrix) 

Pentium class CPU (Includes 
AMD and Cyrix) 

CPU speed 800MHz or faster 500MHz 

Free
2
 memory 64Mb or more 32Mb 

Free
3
 hard disk space 100Mb or more 100Mb 

I/O port
4
 2 x USB 1.1 or 2.0 USB 1.1 

Pointing device Mouse, trackball, touch pad, etc. 

Keyboard Standard PC keyboard 

Screen Standard PC Screen 

Operating System Win2K, WinXP Win98, WinMe 

 
1
 PC configurations that are below the recommended configuration may not support the full features of 

EFILive. For example, a 230MHz Pentium may not be able to update all the gauges on the default 
dashboard while logging real time data at 10 frames per second. In such cases you can reconfigure 
EFILive, see Appendix-G How to optimize data logging. 

2
 Free memory means memory that is not already in use by Windows. 

3
 Free hard disk space means space that is not already in use by Windows. 

4
 Two USB ports are only required if you are upgrading from FlashScan V1 to FlashScan V2. 

The specifications quoted above are required for running the Tuning Tool editing software. 
 

 
Reading and reflashing operations do not require a fast CPU. EFILive has tested reading 
and reflashing the PCM using a laptop with a 250MHz Pentium CPU. If you have an old 
laptop that you want to use for “garage duty” then it is acceptable to use a lower spec than 
the minimum quoted above for reading and re-flashing the PCM. 

 



EFILive V7 Tuning Tool for GM Vehicles 

support@efilive.com - 11 - www.efilive.com 

OBD II cable 

Cable type Supports 
EFILive FlashScan V1  Standard and Professional Scan Tool 

 Personal, Commercial Scan and Tune Tool with up 
to 25 PCM licenses. 

 Workshop Scan and Tune Tool with unlimited PCM 
licenses. 

EFILive FlashScan V2  Scan Only Tool. 

 Scan and Tuning Tool with up to 221 VIN licenses 
and/or stream licenses for unlimited tuning. 

 

Vehicle 

Vehicle/Powertrain  
GM LS1 and compatible controllers 
SAE J1850 VPW 

Supported 

GM LS2 and compatible controllers 
GM CAN (GM-LAN) 

Supported 

Ford SAE J1850 PWM Not supported. 

DaimlerChrysler ISO 9141-2 Not supported. 
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Tutorials 

EFILive Tutorials are available via the Help menu in both the Scan Tool; and Tuning Tool Software 
packages. 

 

 
Help->Tutorials 

Most tutorials are Adobe PDF documents and can be found in the folder: 
\Program Files\EFILive\V7\Docs\Tutorials 
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SSEETTUUPP  GGUUIIDDEE  

Connecting and starting 

Location of the OBD II connector 

The OBD II connector is located in the passenger compartment within reach of a technician seated in the 
driver’s seat. 
Access to the connector does not require any special tools for the removal of any instrument panel 
cover, connector cover or any barriers that may be obscuring the connector. 

 

 

 

 
Left hand drive Right hand drive 

Connecting your FlashScan V2 USB interface cable 

If your computer is fitted with a USB port, connect the FlashScan interface cable as shown in this 
diagram.  

If your computer is not fitted with a USB port then you cannot use that computer with a FlashScan 
interface cable. 

 

 

WARNING 

The RJ45 connector used on FlashScan’s OBDII cable is 
the same size as a standard network cable plug. Never 
connect the OBDII cable directly to your computer’s 
network socket. You will almost certainly damage your 
PC’s network connection. 

And never connect FlashScan directly to a network 
cable, you may damage the FlashScan interface. 
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Connecting your FlashScan V2 interface for black-box logging 

To record data directly to your FlashScan interface, connect it to your vehicle like this. 

 

 

 
The initial release of FlashScan V2 does not support black box logging. Black box logging 
will be made available free of charge via Internet download, when it is available for 
FlashScan V2. 
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Connecting your FlashScan V1 USB interface cable 

If your computer is fitted with a USB port, connect the FlashScan interface cable as shown in this 
diagram. 

 

If your computer is not fitted with a USB port then you cannot use that computer with your FlashScan 
interface cable. 
 

 
Never connect the OBD II cable directly to your computer’s RS232 serial COM port. 

 

Connecting your FlashScan V1 interface for black-box logging 

To record data directly to your FlashScan interface, connect it to your vehicle like this. 

 

 

 Using a USB to RS232 Serial converter 

You cannot use a USB to serial converter with the EFILive FlashScan interface cable. 
 

 
Never connect the OBD II cable directly to your computer’s RS232 serial COM port. 
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Starting the EFILive Tuning Tool 

There are three simple ways to start the Tuning Tool: 

 Double click on the EFILive Tuning Tool icon on the Windows desktop that looks like this: 
 

 
 

 Click on Windows Start button, then select: Programs->EFILiveV7->Tuning Tool 
 

 Double click on any *.tun (tune file). 
The Tuning Tool will start automatically, and display the selected tune file. 
 

 
You may start multiple instances of the Tuning Tool 
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HHOOTTKKEEYYSS  QQUUIICCKK  RREEFFEERREENNCCEE  

Main Display Hotkeys 

Hotkey Description 
F1 Help. 

F2 Restore calibration window to show graphic, table and description. 

F3 Show graphic only. 

F4 Show table only. 

F5 Open currently selected Navigator item. 

F7 Decrease selected table cells by 1.0 (see also Ctrl+F7). 

F8 Increase selected table cells by 1.0 (see also Ctrl+F8). 

F9 Set selected cells to the value in the toolbar [Adjust] field. 

F10 Increase selected cells by the value in the toolbar [Adjust] field. 
Use a negative value to decrease selected cells. 

F11 Increase selected cells by the percentage in the toolbar [Adjust] field. 
Use a negative value to decrease selected cells. 

F12 Apply smoothing to the selected cells. (See also: Alt+F1) 

  

Ctrl+F1 Hide/Show navigator. 

Ctrl+F2 Show calibration window. 

Ctrl+F3 Close all windows. 

Ctrl+F4 Close current window. 

Ctrl+F6 Show next calibration window. (See also Shift+Ctrl+F6) 

Shift+Ctrl+F6 Show previous calibration window. (See also Ctrl+F6) 

Ctrl+F7 Decrease selected table cells by 0.1 (see also F7). 

Ctrl+F8 Increase selected table cells by 0.1 (see also F8). 

Ctrl+F10 Display EFILive Scan Tool. 

Ctrl+F11 Load alternate calibration for comparison. 

Ctrl+F12 Display calibration difference summary. 

  

Shift+F12 Make surface map linear from left to right. 

Shift+Ctrl+F12 Make surface map linear from top to bottom. 

Shift+Alt+F12 Make surface map linear from left to right and top to bottom. 

  

Alt+F1 Open navigator at the current calibration. 

Alt+F2 Show blending/smoothing window. 

Alt+F4 Exit EFILive Tuning Tool. 

Alt+F12 Apply smoothing with min and max anchors, to the selected cells. 
(See also: F12) 

  

Ctrl+Tab Show next calibration window. (See also Shift+Ctrl+Tab) 

Shift+Ctrl+Tab Show previous calibration window. (See also Ctrl+Tab) 

Alt+Enter Display properties window. 

  

Ctrl+Alt+Left Show previously visited calibration. 

Ctrl+Alt+Right Show next visited calibration. 
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Hotkey Description 

  
Ctrl+2 Show 2D chart. 

Ctrl+3 Show 3D chart. 

Ctrl+4 Show calibration data. 

Ctrl+5 Show alternate calibration data. 

Ctrl+6 Show calibration differences. 

Ctrl+0 Rotate 3D chart 90 degrees clockwise. 

  

Ctrl+= (Ctrl++) Increase selected cells by currently selected precision. 
(See also Ctrl+Alt+O and Ctrl+Alt+I). 

Ctrl+- Decrease selected cells by currently selected precision.  
(See also Ctrl+Alt+O and Ctrl+Alt+I). 

  

Ctrl+PgUp Get PCM calibrations. 

Ctrl+PgDn Reflash PCM calibrations. 

Ctrl+Alt+PgDn Reflash PCM operating system and calibrations. 

Ctrl+Alt+PgUp Show PCM information. 

Ctrl+Home Configure PCM locking and/or perform VAT relink. 

  

Ctrl+A Select all cells in calibration table. 
Select all text in edit field. 

Ctrl+B Turn blending on or off. 

Ctrl+C Copy selected data to the Windows clipboard. 

Ctrl+F Toggle “fixed width cells” on or off. 

Ctrl+L Set blending style to Linear. 

Ctrl+M Show modification summary. 

Ctrl+O Open a*.tun or *.bin file for editing. 

Ctrl+P Open and display, then optionally run a script file (see also Shift+Ctrl+P). 

Ctrl+Q Set blending style to Quadratic. 

Ctrl+R Revert current calibration to last saved version. 

Ctrl+S Save current calibration. 

Ctrl+T Save current calibration with a new name. 

Ctrl+V Paste data from the Windows clipboard. 

Ctrl+Z Undo changes (up to 256 times). 

  

Ctrl+Ins Open Windows Notepad. 

Ctrl+Right Expand current branch in Navigator. 

Backspace Go to parent item in Navigator. 

  

Shift+Ctrl+C Copy (special) selected data to the Windows clipboard. 

Shift+Ctrl+V Paste (special) data from the Windows clipboard. 

  

Shift+Ctrl+P Create a script file (see also Ctrl+P). 

  

Shift+Ctrl+Z Redo changes that have previously been undone. 

  

Ctrl+Alt+I Increase display precision (See also Ctrl++ and Ctrl+-). 

Ctrl+Alt+O Decrease display precision (See also Ctrl++ and Ctrl+-). 
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Navigator Hotkeys 

 

Hotkey Description 
Up Move up to previous item. 

Down Move down to next item. 

Left Close expanded item 

Right Open expanded item 

  

Ctrl+Up Scroll Navigator view Up 

Ctrl+Down Scroll Navigator view Down 

Ctrl+Left Scroll Navigator view Left 

Ctrl+Right Scroll Navigator view Right 

  

Alt+Left Close current branch 

Alt+Right Open current branch 

Shift+F9 Open current branch and all sub-branches 

Backspace Move to parent branch 

  

Enter Open currently selected Navigator item. 

Ctrl+Enter Toggle focus between Navigator and current calibration window. 

  

Shift+Ctrl+1 
through 
Shift+Ctrl+0 

Hotkeys associated with first 10 favorite items. 

 

Units configuration Hotkeys 

Hotkey Description 

  
Ctrl+B Set currently selected calibrations to BASIC group. 

Ctrl+E Set currently selected calibrations to EXPERT group. 

Ctrl+S Set currently selected calibrations to STANDARD group. 

  

Ctrl+I Set currently selected calibrations to Imperial. 

Ctrl+M Set currently selected calibrations to Metric. 

  

Ctrl+0 Set metric data precision to 0. 

Ctrl+1 Set metric data precision to 1. 

Ctrl+2 Set metric data precision to 2. 

Ctrl+3 Set metric data precision to 3. 

Ctrl+4 Set metric data precision to 4. 

Ctrl+5 Set metric data precision to 5. 

Ctrl+6 Set metric data precision to 6. 

  

Shift+Ctrl+0 Set imperial data precision to 0. 

Shift+Ctrl+1 Set imperial data precision to 1. 

Shift+Ctrl+2 Set imperial data precision to 2. 

Shift+Ctrl+3 Set imperial data precision to 3. 

Shift+Ctrl+4 Set imperial data precision to 4. 

Shift+Ctrl+5 Set imperial data precision to 5. 

Shift+Ctrl+6 Set imperial data precision to 6. 
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MMEENNUUSS  

File 

 

Open tuning file 

Opens a tuning file for editing. Files can be either EFILive’s proprietary *.tun format or standard LS1 
*.bin files. 

Open tuning file (read-only) 

Opens a tuning file for editing. Files can be either EFILive’s proprietary *.tun format or standard LS1 
*.bin files. When the file is saved EFILive will not permit you to overwrite the original file. You may 
only save changes to a file with a different name. 

Save tuning file  

Saves the current calibration as a *.tun file. 
 

 
Saving calibrations in standard LS1 *.bin file format is not supported by the EFILive 
Tuning Tool. 

Save tuning file as… 

Saves the current calibration as a *.tun file with a new name. The Tuning Tool automatically appends 
a sequence number to the filename to make it unique. 
 

 
Always save significant changes to your *.tun files using Save as. That way a history 
of sequentially numbered files will be created with each saved change that you make. 

Recent files 

Displays a list of the most recently used tuning files. 
The list can be cleared at any time by selecting File->Recent files->Clear file list. 

Load alternate calibration for comparison 

Loads a second *.tun (or *.bin) file for comparison with the currently loaded file. 

Display calibration difference summary 

Displays a list of differences (or similarities) between the current and alternate calibrations. 

Open item 

Displays the currently selected Navigator calibration item. 

Close item 

Closes the currently displayed calibration. 

Revert 

Reverts the current tuning file to the last saved version – all changes since you last saved the file will 
be discarded. 
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Export calibration list 

Creates an HTML document of all calibrations and their descriptions. 
 

 
HTLM documents can be viewed using any web browser including Mozilla Firefox and 
Microsoft Internet Explorer. 

 

Close tuning file 

Closes all windows and closes the current tuning file. 

Exit 

Exits from the EFILive Tuning Tool. 
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Edit 

 

Modification summary 

Displays a list of all modifications made to the current calibration since it was last saved. 

Data conversion  

Provides a unit conversion calculator and table data import export option. The table ‘s rows and 
columns may be transposed before exporting of after importing. 

Undo 

Undoes the last change to the current calibration. 

Redo 

Re applies the last “undone” change to the current calibration. 

Revert 

Reverts the current calibration to the same data that was present when the tuning file was last 
saved. 

Select all 

Selects all cells of the current calibration. 

Cut 

Copies selected data to the Windows clipboard and then deletes the selected data. (Not applicable 
to calibration data). 

Copy 

Copies selected data to the Windows clipboard. 

Copy with labels 

Copies selected data (including row and column headers) to the Windows clipboard. 

Paste 

Paste 

Pastes data from the Windows clipboard to the calibration starting at the top, left selected cell. 

Paste with labels 

Pastes data from the Windows clipboard to the calibration starting at the matching row and 
column of the top left cell of the data on the clipboard. Use this option in conjunction with Copy 
with labels to copy data from identical calibration maps so that the data is will be placed in the 
same cell locations from which it was copied. 
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Paste and add 

Pastes data from the Windows clipboard to the calibration starting at the top, left selected cell. 
The data in the clipboard is added to the data in the calibration. 

Paste and subtract 

Pastes data from the Windows clipboard to the calibration starting at the top, left selected cell. 
The data in the clipboard is subtracted from the data in the calibration. 

Paste and multiply 

Pastes data from the Windows clipboard to the calibration starting at the top, left selected cell. 
The data in the clipboard is multiplied with the data in the calibration. 

Paste and add with labels 

Pastes data from the Windows clipboard to the calibration for cells with row and column labels 
that match the row and column labels in the clipboard data. The data in the clipboard is added to 
the data in the calibration. 

Paste and subtract with labels 

Pastes data from the Windows clipboard to the calibration for cells with row and column labels 
that match the row and column labels in the clipboard data. The data in the clipboard is 
subtracted from the data in the calibration. 

Paste and multiply with labels 

Pastes data from the Windows clipboard to the calibration for cells with row and column labels 
that match the row and column labels in the clipboard data. The data in the clipboard is 
multiplied with the data in the calibration. 

Copy entire segment 

Copies the selected segment from the alternate calibration to the current calibration. Any changes 
that you have made to the current calibration, in that segment, will be overwritten 

Create script 

Creates a script file based on the differences between the current file and the alternate file. Before 
this option can be used, an alternate file must be loaded via the menu option File->Load alternate 
calibration for comparison. 

Run script 

Select and run a script file to automate calibration modification tasks. The script file cannot be edited 
in EFILive, you must use an external editor such as Notepad. 

Open Notepad 

Opens Windows Notepad for taking notes. You are responsible for saving and organizing the files 
created by Windows Notepad. 

Configure display units 

Configures display units and data precision. (See page 59) 



EFILive V7 Tuning Tool for GM Vehicles 

support@efilive.com - 24 - www.efilive.com 

Properties 

The Properties window is where you can customize the Tuning Tool parameters. (See page 61). 
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View 

 

Hide/Show navigator 

Hide or show the navigator panel 

Find in navigator 

Find matching entry in navigator and expand the Navigator to display the entry. 

Expand current branch 

Expands the current Navigator branch and all branches that it contains. 

Navigator ↔ calibration 

Toggles keyboard input focus between the current calibration and the Navigator. 

Show calibration window 

Show calibration window. This is the window that displays information about the entire calibration. 

Restore toolbars 

Restored toolbars’ size and position to installation defaults. 
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Calibration 

 

Show 2D chart 

Show two-dimensional chart of table data 

Show 3D surface map 

Show three-dimensional surface map of table data 

Show calibration data 

Show current calibration data 

Show alternate calibration data 

Show alternate calibration data. The alternate calibration cannot be modified and is displayed with 
inverse left and top labels. 

    

 Current Alternate Difference 

Show calibration differences 

Display differences in cell values between current and alternate calibrations. The difference is 
calculated as current-alternate. 
The calibration difference cannot be modified and is displayed with grey left and top labels. 

Show percentage differences 

Display the relative percentage difference between the current and alternate calibrations. The 
difference is calculated as ((current-alternate)*100)/alternate. This value is useful for comparing 
the changes between cells in the same calibration. 
The calibration difference cannot be modified and is displayed with grey left and top labels. 

Show absolute percentage differences 

Display the absolute percentage difference between the current and alternate calibrations. The 
difference is calculated as ((current-alternate)*100)/(max-min). This value is useful for comparing 
the magnitude of the change(s). It will also be the same as the percentage difference displayed by 
the calibration comparison option. 
The calibration difference cannot be modified and is displayed with grey left and top labels. 
 

 
The difference comparison (current-alternate) or (alternate-current) is controlled by 
the “Calibration difference calculation” setting on the [Options] tab page of the 
Properties window. 

Rotate 90 degrees 

Select preset 3D surface map rotations. 
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Restore normal display 

Resizes and repositions the 3D surface map. 
Resizes and displays all three sections of the calibration window. 

Show graphic only 

Hides the description and the table data and expands the graphic display to fill the entire calibration 
window. 

Show table data only 

Hides the description and the graphic and expands the table data to fill the entire calibration window. 

Fixed width cells 

Normally, the table data display automatically reduces the size of each column to minimize the entire 
table’s width. This can alter the linear perspective of the data in the table. Use this option to force 
EFILive to keep all columns the same width. 

Increase precision 

Increases the displayed precision of the calibration data. The maximum display precision is 6 
decimal places. The display precision does not affect the underlying data precision. 
 

 
The default precision can be customized per calibration. (See page 59) 

Decrease precision 

Decreases the displayed precision of the calibration data. The display precision does not affect the 
underlying data precision. 
 

 
Using the Ctrl+= (aka Ctrl++) and Ctrl+- hotkeys increases and decreases the selected 
cells by the currently displayed precision. By changing the display precision, you also 
change the amount by which these two hotkeys alter the calibration data. 
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Flash 

 

Read PCM calibrations 

Read your PCM’s complete memory image. 
 

 
Backup your PCM before making any changes to it! 
Before ever attempting to reflash your PCM we recommend that you read your PCM’s 
original memory image, burn it onto a CD and store it in a safe place. Preferably, save 
it on more than one CD and store the CDs in more than once place. 

Program PCM calibrations 

Reflash the connected PCM (vehicle) with the current calibration. You can only use this option once 
you have saved changes to the current calibration. 

You must check the checkbox at the bottom of the Legal warnings window in order to continue. The 
warning may be disabled in the Properties window on the [Warnings] tab page. 
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Program PCM operating system and calibrations 

Fully reflash the connected PCM (vehicle) with the current operating system and calibration. 

You must check the checkbox at the bottom of the window in order to continue. The warning may be 
disabled in the Properties window on the [Warnings] tab page. 

 

 

Show PCM info... 

Read and display calibration details from the currently connected PCM. 

PCM security... 

Configure PCM locking and/or perform VAT re-link. 
 

 
PCM locking is not available in the Personal version. 
However, the personal version can unlock PCM’s (if you supply the correct unlock key) 
and the personal version can perform VAT re-link (if the PCM is unlocked, or you know 
the key). 

RoadRunner control panel 

Hides/shows the RoadRunner control panel (or toolbar). 

Display EFILive Scan Tool 

Starts the EFILive Scan tool application. 



EFILive V7 Tuning Tool for GM Vehicles 

support@efilive.com - 30 - www.efilive.com 

Window 

 

Cascade 

Positions and resizes all open windows so that they cascade through the calibration display area. 

Tile horizontally 

Tiles all open windows horizontally. This option is really only useful when a small number of windows 
are open. 

Tile vertically 

Tiles all open windows vertically. This option is really only useful when a small number of windows 
are open. 

Fit to Scan Tool 

Resizes and repositions the Tuning Tool window to the lower x% of the screen. X is defined in 
Properties->Scanner->Scan Tool startup options->Size. 

Close all windows 

Closes all calibration windows. Use this option to quickly clean up all the currently open calibrations. 
 

 
Each time you double click on a calibration in the Navigator, a new window is created 
in which to display that calibration. It is easy to end up with many calibration windows 
open simultaneously. EFILive recommend that you keep the number of open 
calibration windows to less than about twenty-five. 
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Help 

 

Help contents 

Displays this document. 
 

 
The Scan Tool looks for this document called <install_folder>\Doc\EFILiveV7Tune.pdf. 
It must exist, and Adobe Acrobat Reader must be installed on the computer, for the 
Help menu option to succeed. 

You can download the latest version of this document (EFILiveV7Tune.pdf) here: 
www.efilive.com/downloads 

You can download the free Adobe Acrobat Reader here: 
Get Adobe Reader 

Tutorials 

Lists all *.pdf documents in the folder: Program Files\EFILive\V7\Docs\Tutorials. New and updated 
tutorials will be published from time to time and made available here http://www.efilive.com/doc. 
Download them and place them in the tutorials folder and they will appear in the Tutorials menu. 

EFILive home page 

Opens the computer’s default browser and attempts to navigate to EFILive’s home page at 
www.efilive.com. 

EFILive online forum 

Opens the computer’s default browser and attempts to navigate to EFILive’s forum page at 
http://forum.efilive.com/. 

Register EFILive... 

Opens the registration window where you can add or change registration details. 
 

 
Do not attempt to alter the license details from the Scan Tool and the Tuning Tool at 
the same time. 

FlashScan V1 PCM Licensing... 

Displays the FlashScan V1 Licensing window that can be used to upgrade your FlashScan cable or 
to add more PCM licenses to your Personal cable. (See page 92) 

FlashScan V2 VIN Licensing... 

Displays the FlashScan V2 Licensing window that can be used to upgrade your FlashScan cable or 
to add more VIN licenses to your cable. (See page 92) 

FlashScan V2 Upgrade... 

Displays the FlashScan V2 Upgrade window that is used to transfer PCM licenses from a V1 cable 
to VIN licenses on a V2 cable. This option is required only if you are upgrading from FlashScan V1 to 
FlashScan V2. (See the FlashScan V2 Quick Start booklet for more information). 

http://www.efilive.com/downloads
http://www.adobe.com/products/acrobat/readstep2.html
http://www.efilive.com/doc
http://www.efilive.com/
http://forum.efilive.com/
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About... 

Displays version information about the Tuning Tool and programming credits. 
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RREEGGIISSTTEERRIINNGG  YYOOUURR  IINNTTEERRFFAACCEE  CCAABBLLEE  

Entering your license details 

In the past, EFILive had been copied and occasionally, illegally distributed via the Internet. To protect our 
investment in EFILive (and ultimately yours too), we require you to enter a registration key, supplied by 
EFILive, which activates the EFILive software. The registration key prevents un-authorized use of the 
EFILive software and hardware. 

EFILive can store up to five separate interface cable licenses. If you have upgraded from an AutoTap 
interface cable to a FlashScan interface cable, or if you have purchased more than one FlashScan 
interface cable, then you will have multiple EFILive registration keys. You should enter all registration 
keys into the License Manager. 

The registration details are “case sensitive”, which means you must use exactly the same capitalization 
when entering the details. 

 

The order in which you enter the license details is not important. EFILive will always use the license that 
matches the connected cable. If no cable is connected, EFILive will use the license that provides the 
most functionality. For example, if you had an EFILive Standard license for your AutoTap cable and an 
EFILive Personal Scan&Tune license for your FlashScan cable, then EFILive would use the EFILive 
Personal Scan&Tune license if no cable was connected. 

Changes that you make to the license details will not take effect until the next time you open a *.tun file. 
 

 
EFILive will not check the license details when you enter them. If any details are incorrect, 
you will not be informed immediately. EFILive will silently ignore all invalid licenses when 
searching for a valid license. 
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Serial number: is the serial number of your interface cable. The serial number must be exactly 12 digits 
long. If your interface has more or less digits, then either add or remove leading zeros (000123456789) 
to make it exactly 12 digits. 

RoadRunner serial: is the RoadRunner serial number if you are using a RoadRunner real-time 
emulator. If you are not licensed to use a RoadRunner real-time emulator then leave this field blank.  

Type: is the license type. You must specify the correct license type that you purchased, or the license 
will be ignored. 

Issue date: is the date the license was issued by EFILive. It must match the date printed on your blue 
License Registration Card. 

Key: is the 4-part, 16 letter registration key. All characters must be uppercase letters; no digits or 
punctuation characters are allowed. Any characters other than uppercase letters will be rejected. 
 

 
If your license details have been emailed to you, highlight the license details in the email and 
press Ctrl+C. Then click the [Paste] button in the License Manager window. 

 

 
The Full Reflash, PCM-locking and Electronic Throttle Control (ETC) options are only 
available/present when the FlashScan cable is connected to the PC. 

The Full Reflash, PCM-locking options may only be used when EFILive is connected to a 
vehicle. That implies the FlashScan cable must be connected. 

The Electronic Throttle Control (ETC) (and any other future dangerous calibrations) are 
only available in the Commercial and Workshop versions. This is done to maintain the 
assurance that our Personal version is "safe” and will not, and can not render your PCM 
inoperable. The Commercial and Workshop versions have features that can, in rare 
circumstances, render your PCM inoperable.  

To "prove" that your version of EFILive is a licensed Commercial or Workshop version 
requires that you have a valid Commercial or Workshop FlashScan cable connected to your 
PC prior* to starting the EFILive software.  
Otherwise, every Personal version of EFILive could be illegally upgraded to Commercial 
simply by copying someone else's Commercial license details.  

* The reason that the cable must be connected prior to starting up EFILive is so that once 
EFILive is started, the cable may be unplugged and used by someone else for reflashing 
duties while you continue to edit your Commercial calibrations. EFILive only needs to "see" 
the cable once, each time it starts. 
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How to prevent the “Unregistered version” message 

 

If you attempt to start the Tuning Tool software without your FlashScan cable connected to the PC, and 
without having entering the correct registration details, the Tuning Tool software will default to a 
“Restricted Demo Version””. 

The demo version restricts the tasks you can perform: 

 You cannot save any alterations. 

 You cannot read nor reflash a PCM. 

 
The Tuning Tool software only checks for the presence of a cable and/or the license details 
when it is first started, and after any license details have been changed. 

To prevent the “Unregistered version” message from appearing you must either have your cable plugged 
in when the Tuning Tool software is started, or you must enter your license details correctly, or both. 

If your license details are entered incorrectly, you will not have any indication until you see the 
“Unregistered version” message. 
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SSCCRREEEENN  DDIISSPPLLAAYYSS  

Main window 

 

 

The main display is implemented as a standard Windows Multi Document Interface (MDI) 
application. That means the EFILive Tuning Tool software has one large window that can contain 
none, one, or more child windows. Each of these child windows can display a calibration table or a 
set of parameters. 

Each time you open a new calibration by double clicking on the calibration entry in the Navigator at 
the left, a new window will be created. It is possible to open hundreds of calibrations simultaneously. 
We recommend that you keep the number of open calibrations to less than about twenty-five. 

Menu and Toolbars 

 

 

The menu and toolbars are not permanently customizable, in the current release. You can move the 
toolbars around, but their positions revert to match the above display when the EFILive Tuning Tool 
is restarted. 
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Navigator 

The Navigator operates similar to Window Explorer. Calibrations are presented in 8 groups (also called PCM 
segments): 

1.  EFILive custom calibration (operating system segment). 

EFILive releases customised operating systems. All EFILive specific calibrations are listed under this 
segment. Stock calibrations will show this segment as empty. 

2.  Engine calibrations 

The segment contains all the calibrations for modifying the parameters associated with the engine. 

3.  Engine diagnostics 

The segment contains all the calibrations for modifying the parameters associated with the engine 
diagnostics. 

4.  Transmission calibrations 

The segment contains all the calibrations for modifying the parameters associated with the 
transmission. 

5.  Transmission diagnostics 

The segment contains all the calibrations for modifying the parameters associated with the 
transmission diagnostics (such as fault code enable/disable). 

6.  Fuel system 

The Fuel System segment contains calibrations for your fuel gauge. 

7.  System 

The segment contains all the calibrations for modifying the parameters associated with the PCM 
system control. 

8.  Speedometer 

The segment contains all the calibrations for modifying the parameters associated with vehicle 
speed calculations. 

Navigator Icons  

Icon Modified Description 

  Folder containing one or more calibrations. 

  3D map calibration. 

  Multiple, related 2D calibrations. 

  Single 2D calibration. 

  Set of parameters. 

The folder icon shows a blue tab to indicate that one or more calibrations inside the folder have been 
modified. 

The calibration icons in the Navigator show blue checkmarks in all four corners when the underlying 
calibration data that they represent has been changed since the last time the calibration was saved. 
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Searching for Calibrations 

Enter any text into the drop down list to the left of the search button. Then click [Search] to find the next 
calibration that contains the text that you entered. 

The text you entered is searched for in each calibration’s: name, caption (which appears in the 
Navigator) and description. All words entered must appear somewhere in the calibration for a match to 
be successful. If you enclose multiple words in double quotation characters then the exact phrase must 
be found for the search to be successful. 

If a search is successful, the calibration will be opened and the Navigator will be expanded to reveal the 
Calibration entry. Unlike a word processor, the search text is not highlighted. 
 

 
If you want to search for a calibration id, enclose the calibration id in curly braces like this: 
{B1010}. That will find the calibration with that name, but not other calibrations that may 
reference that id in their descriptions. 

Displaying Calibration Groups 

Calibrations can be grouped into three types: Basic, Standard and Expert. The actual names are not 
particularly relevant and calibrations may be arbitrarily placed in any group. By default they are grouped 
according to what EFILive considers as Basic, Standard and Expert calibrations. 
 

 
You can change the group to which a calibration belongs using the Configure display 
units... option. (See page 59). 

Grouping calibrations allows you to “hide” the calibrations that you use rarely and show the calibrations 
that you use often. By selecting the appropriate group name in the drop down list box in the Navigator 
you restrict the calibrations that are displayed to only the selected group or lower. 
 

Group Selection Calibrations displayed in the Navigator 

Basic Basic 

Standard Basic and Standard. 

Expert Basic, Standard and Expert. 

All  Basic, Standard and Expert.  
Currently, there is no difference between selecting All or Expert. 

Favorites 

Calibrations can be saved in the Favorites tab page of the Navigator display. Use the button in the 
Navigator display to add the calibration directly from the Navigator. Use the button in the calibration 
window toolbar to add that calibration to the favourites display. 
 

[ ] Add to favorites. 

The first ten favorites can be opened using the hotkeys Shift+Ctrl+1 through Shift+Ctrl+0. 
All other favorites can be opened by double-clicking on the favorite item. 
 

 

Re-order the list of favorites by selecting an item and clicking on the up or down 
arrow keys at the bottom of the favorites display. 
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Calibration Display 

The calibration display is the main work area of the EFILive Tuning Tool. Calibrations are displayed in 
separate, child windows. Child windows can be minimized, normal or maximized.  

A minimized window appears as a small icon at the bottom of the calibration display area. 

A normal window appears with a title bar and window borders within the confines of the main EFILive 
Tuning Tool window. 

A maximized window expands to the size of the calibration display. Its title bar information is appended 
to the main EFILive Tuning Tool window title bar information. 

PCM Details 

 

The PCM calibration window displays: 

VIN: Vehicle Identification Number. If this number is different to your windshield VIN, you can use 
the EFILive V7 Scan Tool to safely change the VIN in the PCM. 

1997 and 1998 F and Y body PCMs Do not store the VIN in the extracted *.tun or *.tun file. It is 
therefore displayed as N/A. 

Engine: Displays the engine size and type. 

1997 and 1998 F and Y body PCMs Do not store the Engine Type in the extracted *.tun or *.tun file. 
It is therefore displayed as N/A. 

Transmission: Displays the transmission type. 

PCM flash: Displays the size of the PCM flash memory. 
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OS: Operating System number. This number is extremely important. It identifies the program version 
of your operating system. You can only reflash *.tun files with an identical operating system number 
into your PCM. EFILive Tuning Tool enforces that restriction. 

 
The Commercial and Workshop versions of EFILive’s Tuning Tool, allow you to convert 
PCMs between operating systems. Doing so is potentially hazardous to the PCM and 
is not offered as part of the Personal version. 

Calibration: identifies the overall calibration identification. 

OS ID: A two-letter code that further identifies the operating system. EFILive custom operating 
systems have the designation: Vx, where “x” is the custom operating system’s version number, 
between 1 and 9. 

1997 and 1998 F and Y body PCMs Do not store the OS-ID in the extracted *.tun or *.tun file. It is 
therefore displayed as N/A. 

BCC: Broadcast code. This is a form of PCM identification; you may set this value to any 4 alpha-
numeric identifier. 

1997 and 1998 F and Y body PCMs Do not store the BCC in the extracted *.tun or *.tun file. It is 
therefore displayed as N/A. 

EFILive calibration definition file (*.cal): Shows the calibration definition file currently being used 
to decode the *.tun file calibrations. The version number and date indicate the version and release 
date of the calibration definition file. 

 
It is important that the latest calibration definition files are installed. Free updates may 
be downloaded from EFILive’s web site: www.efilive.com/downloads 

Segments: Displays the eight PCM segment part numbers (values that identify the factory 
calibration) and their correct checksum as calculated by EFILive. If the checksum calculated by 
EFILive is different to the checksum in the calibration file, then a red cross is displayed next to the 
segment name. For safety reasons, *.tun and *.bin files that have one or more incorrect checksums, 
cannot be flashed in to the PCM. 

1997 and 1998 F and Y body PCMs only contain one segment, the Operating System segment. All 
other segments will correctly show: N/A. 

Comments 

You can save comments about the current calibrations. These comments are only saved in the *.tun 
file. The comments are not saved in the PCM’s flash memory. 

History 

EFILive automatically keeps a history of all changes made to the calibration. You may edit the 
history data; search for text or for particular dates. 

http://www.efilive.com/downloads
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Out of Range 

EFILive enforces two sets of limits on each calibration’s value(s), a hard limit set by the PCM and a 
soft limit set by EFILive. The soft limits are displayed at the top of each calibration window, labelled 
as Minimum and Maximum. If any calibration value exceeds the soft limits but not the hard limits, 
then that value is displayed with a thin red border indicating that the value is probably out of range. 
The hard limits, not displayed, are usually the same as the soft limits, except in rare cases where 
EFILive adopts a more conservative limit than the PCM. For example, the hard limits for spark 
advance are –64 to 64 degrees. EFILive imposes a more conservative set of soft limits of between -
60 and 60 degrees. 
The hard limits cannot be exceeded. If a calibration file is loaded containing values that exceed 
the hard limits, those values will be coerced so that they lie within the hard limits and reported in the 
“Out of Range” tab page. 
EFILive will not permanently alter the "Out of Range" values, unless that calibration window is 
opened and at least one cell value is changed. In that case, all cells will be saved with their current 
“in range” values. 

Modifications 

Displays the modifications that have been made to the tuning file since it was last saved. 

Upgrade OS 

Custom operating system upgrades can be applied here. If the currently loaded *.tun or *.bin file has 
already been upgraded to a custom OS, then this page will be blank. Only stock *.tun or *.bin files 
may be upgraded to custom operating systems. 

Compare 

See page 70 for more information about comparing calibrations. 
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Conversions 

 

Select the from and to units, then enter a value to be converted, the converted value appears 
automatically underneath the to units. 

Convert: converts all cells in the table. 

Transpose: swaps the rows and columns of data in the table. This option is useful when copying 
data to or from other applications. 

Create New Table: creates a new table of data from the data on the clipboard. Use the Copy with 
label option to copy an existing calibration table to the clipboard prior to using the Create New Table 
option. 

 
You may add your own conversion routines to EFILive by adding them to the file: 
\Program Files\EFILive\V7\Configuration\unit_conversions.txt. 

Note: any changes to this file will be overwritten during a software upgrade. You must 
manually save and replace any modifications that you want retained. 
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Calibration maps that display either 2D or 3D graphical and associated tabular data. 

 

The calibration “map” display is split into three sections.: 

1. The top left section displays either a 2D or 3D representation of the tabular data. 
2. The top right section displays a brief description of the purpose of the calibration. 
3. The bottom section displays the tabular data. 

You may resize each section individually by clicking and dragging on the “splitter” bars between the 
sections. The next time the calibration is opened the section sizes will revert to their default sizes. 

 To view the graphic section only, press F3 

 To view the tabular data section only, press F4 

 To restore the view to the default display of all three sections, press F2 
 

 
To swap between 3D view and 2D view use the keys: 

 Ctrl+2 to see the 2D chart. 

 Ctrl+3 to see the 3D view. 

When a map calibration is opened, it will always display using the default 2D or 3D 
graphic. The default graphic is indicated by the icon next to the calibration item in the 
Navigator. 
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Adjusting the 3D graphic display 

You can select cells in the 3D chart by holding the left mouse button down and moving left/right 
and up/down across the 3D chart display. 

You can rotate the 3D chart by holding the right mouse button down and moving left/right and 
up/down across the 3D chart display. 

You can move the 3D chart by holding the Ctrl key and the left mouse button down while moving 
across the 3D chart display. 

You can enlarge or reduce the 3D chart by moving the scroll bar, which is located to the right of 
the 3D chart. 

To return the 3D chart to its normal size, and position, press F2 or F3 – or click on the 
magnifying glass at the bottom of the scroll bar. 

To return the 3D chart to one of its 4 standard orientations, use: 

 Ctrl+7 

 Ctrl+8 

 Ctrl+9 

 Ctrl+0. 
 

 
To modify the calibration data while the 3D (or 2D) chart is displayed, you can use 
the arrow keys to move the highlighted cell across the 3D surface. Use the normal 
hotkeys (F7, F8, Ctrl+F76 and Ctrl+F8) to increase or decrease the current cell’s 
value. 

If blending is active then any modifications will be blended with the surrounding cell 
values.(See page 57) 
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Using 2D charts to edit data 

2D charts display each column of data as a separate series of data points in the chart. 

    

(Screen capture altered for clarity) 

The active series is defined as the data column that contains the selected cell. If you select cells 
from multiple columns in the table, then the column containing the rightmost, selected cell, will 
be the active series. 

In the 2D chart display, the active series is indicated with data points. You may move these data 
points up or down using the mouse. If you drag any data point off the top or bottom of the chart, 
or if you drag the highest or lowest point further inside the chart, then the chart’s vertical axis will 
automatically re-adjust when you release the mouse button. 
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If you select an entire column (by clicking on the column header), then only that series will be 
displayed in the 2D chart and the legend will display all the data point values from that series. As 
you drag the data points with the mouse, the legend is updated with the data point’s value. 

    

(screen image enhanced for clarity) 

  
You can re-map an entire series using the mouse. Place the mouse pointer within 
the chart boundaries, then hold down the left mouse button and drag the mouse 
across the chart from left to right (or right to left). The data points of the active 
series will follow the mouse. 
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Calibrations that display independent parameters. 

Some calibrations are simple values (rather than 1 dimensional or 2 dimensional lookup tables). The 
EFILive Tuning Tool groups these single value calibrations into sets called parameters.  

You can find these parameters inside the “Parameters” calibration item in the Navigator. 

 

Edit parameters by clicking in the cell that you want to change (or by moving to the cell using the 
arrow keys), then type in a new value and press Enter (or Tab or Shift+Tab). If the value is 
unacceptable then EFILive will restore the previous value. For example, you cannot enter the letter 
“A” when the parameter expects a value. 
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Enumerated parameters 

 

Some parameters can only be set to a discrete set of values. These parameters are called 
enumerated parameters.  

To alter the value of an enumerated parameter, either type the first letter of the Possible values, in 
the image above, type: S for Series Parallel, A for Auxiliary, N for No fans or E for EV fan. 

Alternatively, click on the button to select that button’s option. 
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 Lists that display multiple values of the same type 

Some parameter lists are made up of many entries that can all take the same values, such as 
diagnostic trouble codes (DTCs).  

 

These calibrations can be edited the same way as enumerated calibration values. 
 

 You can select multiple cells and alter them all simultaneously. 
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Speedometer Calibrations 

Manufacturers employ various methods to capture road speed and display it to the driver. The GM 
controllers supported by the EFILive Tuning Tool use a Vehicle Speed Sensor (VSS) that is located on 
either the drive shaft or the drive axle. Where the speed sensor is located determines whether the 
differential ratio affects the VSS signal or not. 

The vehicle speed sensor sends a stream of pulses to the PCM. The pulse frequency increases 
proportionally as the road speed increases. The PCM needs to know how many pulses will be received 
in one mile (or one km if you are working in metric). This calibration term, is called pulses per mile (or 
pulses per km if you are working in metric) 

To display the Speedo Calculator, open the Speedo section and select the {H0101} calibration, then click 
on the [Speedo Calculator] button. 

Each value in the speedo calculator is highlighted with a yellow, green or blue background. The colors 
signify the origin of the value that is currently displayed. 

 Yellow indicates values that have been changed by the user. 

 Green indicates values that have been calculated by EFILive. 

 Blue indicates values that match the values in the current calibration file. 
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Recalculating the pulses per mile value after a tire size change and/or differential ratio change is 
easy using EFILive’s built in Speedo calculator. 

Tire size: You may enter either the Tire diameter or the Tire circumference or the Wheel 
Revolutions per Mile (or km), or you may choose to enter your tire’s width, profile and rim 
diameter, then click the button to the right of the Rim entry to have EFILive calculate the tire size for 
you. 

 
A good way to measure your tire size is to measure the distance traveled in one 
complete tire rotation, then enter that value as the Tire circumference. 

Transaxle: Corvettes have a transaxle and have the VSS fitted to the rear axle. 
Check Transaxle if your vehicle has the VSS located on the axle rather than the transmission output 
shaft. (i.e. if it is a Corvette). 

 
EFILive uses the VIN to determine if the calibration is from a Corvette. If the VIN 
is unknown, indeterminate or incorrect, then the Transaxle checkbox may not 
be set correctly. That may cause incorrect values to be displayed in the 
speedometer calculator. In that case, you must check (or uncheck) the 
Transaxle checkbox according to the type of vehicle that you are working with. 

Final drive ratio is usually the differential ratio. If you have changed your differential ratio, enter the 
new differential ratio here. 

 
On vehicles with a transaxle (i.e. Corvettes) the calibrated diff ratio value 
{H0103} may not be correctly calibrated from the factory. 

TOS revs per mile is the number of revolutions of the transmission output shaft (TOS) per mile (or 
per km if you are working in metric). This value is not used in vehicles with manual gearboxes and 
may be set incorrectly (in the 800 to 899 range) in some factory manual calibrations. 

VSS pickup teeth is the number of teeth on the vehicle speed sensor. Usually this value is 17 or 40. 
Generally: most manual cars use 17, most automatic cars use 40. Manual and automatic Corvettes 
use 40. Most trucks use 17. 

VSS pulses per TOS revolution is the number of pulses transmitted to the PCM per revolution of 
the transmission output shaft. This value is not used in vehicles with manual gearboxes and may be 
set incorrectly in some factory manual calibrations. 

 
On vehicles with a transaxle (i.e. Corvettes) this value should be exactly 40 
divided by {H0103} – assuming {H0103} accurately enumerates  the differential 
ratio fitted to the vehicle. 

VSS pulses per mile is the number of pulses transmitted to the PCM per mile (or per km if you are 
working in metric). 

The [Reset] button re-loads the values from the calibration into the speedo calculator. 

The [Apply] button saves the updated values back into the calibration and then displays the [Shift 
Point Correction] tab page to allow transmission shift points to be corrected – if desired. 

 
You may also manually adjust transmission shift speed calibrations. Open the 
appropriate shift point calibration table and select the entire table by clicking in 
the upper left hand corner grey cell. Then enter the percentage change (without 
the % sign) in the Adjust text box in the toolbar. Then click on the [%] toolbar 
icon. 
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Sprocket Ratio Calibrations 

The 4T60-E and 4T65-E transmissions contain two chain driven sprockets. These sprockets may have 
varying number of teeth. The number of teeth is commonly 33, 35 and 37, however that may not always be 
the case. 

Using EFILive’s Sprocket Ratio calculator, you can determine the Sprocket Ratio and Calculated (or 
Estimated) final drive ratio. 

 

Drive sprocket is the number of teeth on the driven sprocket. 

Driven sprocket is the number of teeth on the drive sprocket. 

Sprocket Ratio is the effective gearing achieved with the two sprocket sizes that have been 
entered. 

Differential Ratio is the ratio of the differential gears fitted to the transmission. 

Calculated final driver ratio is the adjusted differential ratio taking into account the sprocket ratio 
defined by the drive and driven sprockets. 

The [Copy to “Final drive ratio”] button copies the Calculated final drive ratio into the Final 
drive ratio text box in the [Speedo Calculator] tab page. 

The [Reset] button re-loads the values from the calibration into the speedo calculator. 

The [Apply] button saves the updated values back into the calibration. 
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Speedo fine tuning 

Sometimes a speedometer may only be out by a few mph (or km/h if you are working in metric). In that 
case the best way to correct the speedometer is to apply a percentage correction. 

 

Displayed speed is the speed displayed on your instrument cluster. The value may be entered as 
either mph or km/h. Do not enter the units into the text box, only enter the numeric value. 

Actual speed is the true speed of the vehicle. The true speed should be measured using an 
independent device, such as a GPS or radar gun. The value MUST be entered using the same units 
(mph or km/h) as the Displayed speed value. Do not enter the units into the text box, only enter the 
numeric value. 

Correction required is the multiplier that will be applied to the pulses per mile (or km if you are 
working in metric). 

 
Some operating systems do not have the {H0101} calibration. In that case this 
fine-tuning option cannot be used. 
However, you may manually apply the displayed multiplier to the appropriate 
calibration(s). 

The [Reset] button re-loads the values from the calibration into the speedo calculator. 

The [Apply] button saves the updated values back into the calibration. 
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Shift Point Correction 

Changing the speedometer calibrations will change the transmission shift points. You will need to adjust 
the transmission shift points so that they continue to shift at the same engine rpm. 

EFILive calculates the appropriate adjustment required to restore the correct rpm shift points after the 
speedo has been adjusted. 
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SSMMOOOOTTHHIINNGG,,BBLLEENNDDIINNGG  AANNDD  FFIILLLLIINNGG  

Smoothing 

 

Smoothing is a process that removes the sharp peaks and troughs from a data series or surface map. 
Smoothing is designed to smooth data after any modifications have been made. (Compare with 
blending, which is applied while the changes are being made). 

The following three images show how smoothing changes the data in the calibration maps. The data you 
are looking at is the Spark Advance ECT modifier calibration from a Holden HSV GTS.  

   
 Original data 1 pass at 100% 5 passes at 100% 

Only selected cells are smoothed, you may select as many or as few cells as you wish. However, you 
cannot smooth just one cell, you must select at least two cells.  

By default, the strength of the smoothing is 50%. To alter the smoothing strength, enter a value between 
1 and 100 in the Adjust text box. Larger values will smooth more aggressively, smaller values will 
smooth gently. 

 
Using the second smoothing icon will prevent the smoothing algorithm from reducing the maximum or 
increasing the minimum cells’ values. This prevents the entire data set from converging to the average 
value of the selected cells. 

 
If, when you click the smooth buttons no smoothing appears to occur, it is probably 
because the Adjust text box contains a very low value. Delete the value in the Adjust text 
box and try again. 
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Linear fill 

 

Linear fill is used to create straight lines between two points in a row or column of data. Or to create a 
flat or uniformly curved plane of data. 

    
 Original data Row fill Column fill Column and row fill 
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Blending 

 

Blending is a process that is applied to alterations as they are made to the data. Blending is a similar 
concept to stretching a rubber sheet. The EFILive Tuning Tool “stretches “ the data points surrounding 
the modified cells so that the modified cells blend with the non-modified cells. 

The following images show how blending affects data modification. In the three modified images, the 
single, highlighted cell was increased from 28 to 33. 

   
 Original data Blending not active 

   
 Quadratic blending active Linear blending active 

In the top right, the modification is unblended and the alteration produces a very sharp peak. 

In the lower left, the modification was blended using the quadratic algorithm. 

In the lower right, the modification was blended using the linear algorithm. 



EFILive V7 Tuning Tool for GM Vehicles 

support@efilive.com - 58 - www.efilive.com 

The following images show a cross-section of how each algorithm affects the cells surrounding the 
modified cell. The modified cell is at the peak, in the center of each display. 

    

 Original data Quadratic blending Linear blending 

 
Activate blending using Ctrl+L for linear blending or Ctrl+Q for quadratic blending. De-activate blending 
using Ctrl+B. 

 
Restrict the shape of the blend area to just rows or just columns. 

 
Adjust the number of cells that blending will affect. The blending size is displayed as a greyscale overlay on 
the 3D graphic and the tabular data. 
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CCOONNFFIIGGUURREE  UUNNIITTSS  

The EFILive Tuning Tool is able to display all calibrations in your choice of units and precision. Each 
calibration map can be customized to either metric or imperial. As well, you can choose the precision (the 
number of decimal places) at which to display the data. 

 

 

 
These values can only be changed if modifications have not been made since the 
calibration file was last saved, and if all calibration windows are closed. If those conditions 
are not met, you will be prompted to meet those conditions. 

For each calibration listed, you can customize the following details: 

Group: to select which group the calibration will be displayed under. You can select groups of 
calibrations for display using the drop down list in the Navigator. 

Prec (SI): The number of decimal places to display when data is displayed in metric. 

Prec (IM): The number of decimal places to display when data is displayed in imperial. 

Data units: The units to use to display the data values. 

Col Units: The units to use to display column labels. 

Row Units: The units to use to display the row labels. 

[All]: Select all calibrations. 

[Invert]: Invert selection. 

[Clear]: unselect all calibrations. 

[Recall]: Recalls installation defaults. 
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[Imperial]: Quickly change ALL units (data, column and row) for all selected calibrations to Imperial. 

[Metric]: Quickly change ALL units (data, column and row) for all selected calibrations to metric. 
 

 
Most US customers who set ALL calibrations to imperial will usually still work with 
some airflow measurements in grams per cylinder (such as the spark tables). 

You can change individual calibrations by selecting them and right clicking and 
selecting the appropriate row or column units. 

To select multiple calibrations hold down the Ctrl key while single clicking each 
calibration. 

To select a range of calibrations, click the first one, and then hold down the shift key 
while single clicking on the last one. 
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PPRROOPPEERRTTIIEESS  

The Properties Window is where you can customize how the EFILive Tuning Tool operates.  

 

Display 

 
Changes made to these properties will only take effect after the calibration file has 
been reloaded. 

Volumetric Efficiency values 

EFILive has the ability to display the Volumetric Efficiency (VE) tables as any one of: 
 The default PCM units of Grams*Kelvin/kPa (Mass*Temperature/Pressure). 
 A percentage of perfect efficiency. 
 The number of grams per cylinder. 
 The number of grams per second. 

If you elect to display the VE table as grams per cylinder or grams per second, then you must supply 
a default charge temperature (in ºC) that EFILive can use to calculate the air mass values. The 
charge temperature is a blend of the engine coolant temperature and the intake air temperature. See 
calibration {B4901} Charge temperature blending, in the Tuning Tool for more information about how 
the charge temperature is calculated. 

To calculate the VE as a percentage, the Tuning Tool uses the cylinder volume calibration {B0104}. 
If that value is not correct, then the VE table will not display correctly as a percentage. 
 

 
If you must change the value of the cylinder volume {B0104}, and you have the VE 
table set to display as a percentage, then we recommend saving, closing and 
reopening the calibration immediately, to prevent any confusion in the displayed VE 
percentages. 
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Air Fuel Ratio calibrations 

Air fuel ratio can be expressed in different ways for different purposes. Many of the tables in the 
PCM are displayed as equivalence ratios. Equivalence ratio is the ratio of fuel to air where 
stoichiometry is defined as 1.00. Many tuners prefer to work with fuel ratios specified in Lambda. 
 

To convert EQ Ratio to AFR, use: 
AFR = {stoich}/EQ 

To convert Lambda to AFR, use: 
AFR = Labmda/{stoich} 

To convert AFR to EQ Ratio, use: 
EQ Ratio = {stoich}/AFR 

To convert Lambda to EQ Ratio, use: 
EQ Ratio = 1/Lambda 

To convert EQ Ratio to Lambda, use: 
Lambda = 1/EQ Ratio 

where {stoich} is defined as the stoichiometric combustion of air and fuel. In the case of gasoline, it 
is 14.7. EFILive uses the PCM’s calibrated value for stoichiometry {B3601}, which may be set slightly 
lower (richer) than 14.7 (i.e. 14.63). If the calibration does not contain {B3601}, then EFILive 
substitutes the value 14.63 for stoichiometry. 

Stoich: You may elect to view the AFR tables using an AFR value that is different than 14.63. See 
Appendix-B for an in-depth explanation of AFR and Stoichiometry. 
 

 
Some EQ Ratio values are defined as zero. Those values cannot be accurately 
represented as an air fuel ratio. EFILive displays EQ Ratio values of zero as 200:1 
AFR. 

Injector Flow Rate 

If the injector flow rate table is configured to display with Imperial units then you may select to see 
the flow rate in lbs/min or lbs/hour. 

If the injector flow rate table is configured to display with Metric units then it will be displayed in 
Grams/Second. 
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Scanner 

Scan Tool Startup Options 

When starting the EFILive Scan Tool via Ctrl+F10, the Tuning Tool can command its own window 
and the Scan tool’s window to resize so that both windows are visible on the screen. 

If Resize Scan and Tune windows is checked then EFILive will resize both windows when the 
Scan Tool is started by the Tuning Tool. 
 

 
A similar property exists in the Scan Tool Property window on the [Options] tab page. 

Size: determines the percentage of screen to which the Tuning Tool will be resized. The remainder 
of the screen will be used by the Scan Tool window. 
 

 
If the Scan tool is minimized when it is requested from the Tuning Tool it will remain 
minimized. 

PID data links 

Highlight Scan Tool selection in Tuning Tool maps, displays the data cells that have been linked 
from the Scan Tool. 

Runway highlighting selects an alternate highlighting method to display data linked from the Scan 
Tool. 

  
 Non-runway highlighting Runway highlighting 
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RoadRunner 

RoadRunner connection type: 

Native USB EFILive will attempt to locate the RoadRunner PCM using the native Windows USB 
API. I fyou have trouble connecting to the RoadRunner device using this option, then use the Virtual 
COM port option instead. 

Virtual COM Port  EFILive will use a virtual COM port to communicate with the RoadRunner PCM. 
This is the preferred option to connect to RoadRunner. 

RoadRunner Native USB device name: 

This option will be displayed when the Native USB option selected. 

Device name: EFILive displays all connected USB devices that could possibly be a RoadRunner 
PCM. The RoadRunner PCM will usually be named: USB <-> Serial 

Preferred COM port:: 

This option will be displayed when the Virtual COM Port option selected. 

COM Port: Select the COM port that is being used by the RoadRunner PCM. If you do not know the 
COM port number, then check the Scan all COM ports check box. EFILive will scan all COM ports 
when you attempt to connect to the RoadRunner device. If a RoadRunner device is found then 
EFILive will update the Preferred COM port. 

Scan to: This limits the number of COM ports that EFILive will scan. 

Realtime alert: 

Sound: The name of a *.wav file that will be played whenever EFILive updates the RoadRunner 
PCM with real-time changes. 

[Play] Plays the sound for testing. 

Play sound when a real-time update occurs: Uncheck this checkbox to prevent the sound from 
being played. 

RTACS (Real Time Automatic Calibration System): 

Fine and Coarse control: 
EFILive uses the fine and coarse values to compute adjustment multipliers as follows: 

 Fine: multiplier = 1-((1-PID)*(FINE/1000))) 

 Coarse: multiplier = 1-((1-PID)*(COARSE/1000)) 

You can select the appropriate RTACS control (fine for coarse) using the RTACS toolbar icons. 

Update frequency: Reduces the number of times EFILive updates the screen. Larger values reduce 
the CPU load. Smaller values increase the CPU load. If you are using a slow computer (<1GHz) try 
setting this value at 10 or above. 

Auto bank swap: Controls the way data updates are sent to the RoadRunner PCM. It should remain 
checked, unless otherwise advised by EFILive.  
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DTCs 

AutoClear DTCs at end of read or reflash will cause EFILive to send the appropriate messages to 
all onboard modules in order to clear any Diagnostic Trouble Codes (DTCs) that may have been set 
during the read or reflash process. 

Clear each module individually will send an addressed Clear DTC command to each module. 

Clear all modules at the same time will send a single broadcast Clear DTC command to all 
modules at the same time. 

Delay Specifies the number of seconds to wait between rebooting the class-2 network and clearing 
DTCs from all modules. A delay of between 500ms and 2 seconds is necessary to prevent EFILive 
from sending the “Clear DTCs” command onto the class-2 network while various modules are 
rebooting and/or initialising. 

If the vehicle’s PCM does not operate correctly after a read or reflash process, increase this value.  
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2D charts 

Series lines 

Width: determines the line width of the series’ lines plotted on the 2D charts. 

Series points 

Points visible: determines if the points will be displayed with a small circle or not. If the points are 
displayed it makes it easier to select and drag the points using the mouse. 

Label points on y-axis: when only one series is visible, the y-axis labels display the data points 
instead of a linear equally spaced scale. 

Point width: vertical size of data point circles in pixels. 

Point height: horizontal size of data point circles in pixels. 
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3D surfaces 

Colors 

Select the item whose color you want to change and then select the color. 

[Custom…]: can be used to create custom colors that are not on the quick selector. 

Grid lines visible: Hides/shows the grid lines. 

X-axis visible: Hides/shows the X-axis labels and title. 

Y-axis visible: Hides/shows the Y-axis labels and title. 

Z-axis visible: Hides/shows the Z-axis labels and title. 

High contrast font colors: Check this box to force font color to black or white so that the cell values 
can been seen on varying background colors. 

Cube style: Select the type of cube-container to be displayed around the 3D chart. 
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Options 

General 

Prompt if search wraps: 

Uncheck this checkbox to cause EFILive to automatically start searching from the top of the 
calibrations if the end of the calibrations was reached with no search match. 

Always save *.blx trace files: 

If a PCM read or PCM reflash operation fails the bootloader trace file contains valuable diagnostic 
information to help EFILive support determine what the problem might be. If you are experiencing 
problems, please check this option and send the generated *.blx files to EFILive support 
(support@efilive.com). 

*.blx files are saved in My Documents\EFILive\V7\Bug Reports\ and their file names include the date 
and time in the following format: 
YYYYMMDD_HHMMSS_download.blx (when reprogramming a PCM) 
YYYYMMDD_HHMMSS_upload.blx (when reading a PCM) 

If you leave this option checked, you will need to periodically clear out the files in the 
\My Documents\EFILive\V7\Bug Reports folder. 

Show timer countdown after read/reflash 

Enables or disables the timer countdown at the end of a PCM reflash or PCM read operation. 
 

 
You may click on the [Stop] button when the countdown is active to terminate the 
countdown early. 

Windows 

Maximum number of open calibration windows: If the number of open calibrations would exceed 
this value then the least recently used calibration window is automatically closed. No data is lost. 

Calibration difference calculation 

You can select whether you want the calibration differences to be displayed as: 
Current calibration values subtracted from the Alternate calibration values 
or 
Alternate calibration values subtracted from the Current calibration values. 

 

mailto:support@efilive.com
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Warnings 

Do not show reflash legal warning: will suppress the legal warning prior to reflashing a PCM. 

Do not show full reflash danger warning: will suppress the full reflash danger warning prior to full-
reflashing a PCM. 
 

 
By disabling warning messages you accept full responsibility for any failures that may 
have been prevented had the warnings been displayed to the user. 

Do not show VIN mismatch warning: will suppress the warning that the logged data file and the 
currently loaded calibration have different VINs. This warning does not indicate an error or fault 
condition. It is to draw your attention to the possibility that you may be unknowingly comparing data 
from two different vehicles. 
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CCAALLIIBBRRAATTIIOONN  CCOOMMPPAARRIISSOONNSS  

EFILive provides a rich set of calibration comparison tools. By loading in two calibrations from the same 
operating system, you can compare each difference (or each similarity) down to the individual cell. 

To load an alternate calibration for comparison use the following option: 
 

 
File-> Load alternate calibration for comparison 

[ ] Load alternate calibration for comparison 

 
Ctrl+F11 

The alternate calibration must be for the same operating system. 

The following three images show two calibration maps: the current calibration that has been smoothed, 
and the alternate calibration that has not been smoothed. The last calibration shows the difference 
between the current and alternate calibration values. 

   
 Current Calibration Alternate Calibration Difference 
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Two extra comparison options allow percentage calibrations to be performed. 

   
 Relative percentage Absolute percentage 

Why have two different percentage comparisons? 

Let’s look at two calibrations in two tun files. In the current tune file we have: 

{D0910} WOT 1->2 Shift Speeds, Normal, with a value of 44 mph and a range of 0-256 mph 
{D0940} WOT 1->2 Shift RPM, Normal, with a value of 5300 rpm and a range of 0-8192 rpm 

In the alternate tune file we have: 

{D0910} WOT 1->2 Shift Speeds, Normal, with a value of 40 mph 
{D0940} WOT 1->2 Shift RPM, Normal, with a value of 5000 rpm 

Comparing the relative percentage difference, we would observe: 

{D0910} (44-40)*100/40 = 10% 
{D0940} (5300-5000)*100/5000 = 6% 

These figures may lead us to incorrectly believe that there is a greater difference between 
the two {D0910} calibrations than between the two {D0940} calibrations. 

However, comparing the absolute percentage difference, we would observe: 

{D0910} (44-40)*100/(256-0) = 1.56% 
{D0940} (5300-5000)*100/(8192-0) = 3.66% 

These figures more accurately show that the two {D0910} calibrations differ by a smaller 
amount than the two {D0940} calibrations. 
These figures are the same figures that are displayed in the comparison summary. 

So, what use are the relative percentage comparisons? If you adjust a group of cells in a calibration, 
then the relative percentage difference will show constant values across all cells that were adjusted 
by the same percentage. 

 

 
The difference comparison (current-alternate) or (alternate-current) is controlled by 
the “Calibration difference calculation” setting on the [Options] tab page of the 
Properties window. 

You may also display a complete comparison summary of all differences (or similarities) between the 
current and alternate calibration. 
 

 
File-> Display calibration difference summary 

[ ] Display calibration difference summary 

 
Ctrl+F12 
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RREEAADDIINNGG  AANNDD  RREEFFLLAASSHHIINNGG  YYOOUURR  PPCCMM  

Reading and reflashing your PCM, locking it, unlocking it and re-linking the security system are probably the 
most important tasks performed by EFILive Tuning Tool. 

The PCM is designed with a multiple levels of protection against accidental alteration of the calibrations and 
program code. Checksums are calculated at key-on to make sure the PCM still contains the exact data that 
was flashed into it, and a security system prevents unauthorized alterations to the calibrations and program 
code. 

EFILive must negotiate both of those systems so that it can read and reflash your PCM correctly. EFILive 
must gain authorized access to the PCM and when finished, must recalculate all checksums correctly to 
ensure that the PCM knows that data altered by EFILive is valid. 

Each time you open the Read, Reflash or Security windows, EFILive attempts to unlock the security system. 
The PCM has built in time delays to prevent “brute force” electronic attacks on the security mechanism. 
While waiting for this time delay, EFILive will display PCM not ready, waiting 5 seconds for retry… 
 

 
This time delay is no more than a 10 second delay between every two unlocking attempts, 
however with 65535 possible combinations, trying them all would take just under 4 days. 

When reading or reflashing the PCM, EFILive attempts to communicate in high speed mode. At high-speed 
the data signal is more susceptible to noise and interference. If EFILive detects too much interference during 
high-speed mode, it will automatically switch to normal speed. Once a switch to normal speed is made, 
EFILive will continue in that mode until the transfer is complete or is aborted by the operator. This may cause 
longer than expected data transfer times. 

During any data transfer, EFILive shows the estimated time remaining, and the number of kilobytes 
transferred. 
 

 
When reading or reflashing the PCM, EFILive is programmed to retry indefinitely. If the read or 
reflashing progress counters have not moved in more than a minute, then the process has 
failed. It is up to the operator to click on the [Stop] button to terminate the process. 

EFILive will recover and continue transferring data when a cable is disconnected, provided the 
cable is reconnected within 5 seconds. If the cable is unplugged for longer than 5 seconds, 
then the PCM aborts the transfer and you must click on the [Stop] button to terminate the 
process. 

 

 

NEVER interrupt the reflash process when the traffic light icon is RED. Doing so may render 
the PCM inoperable and unrecoverable. 
EFILive has a number of built in recovery strategies if the reflash process is ever interrupted 
or fails. (See page 81 for recovery strategies) 

 

 

You may interrupt the reflash process when the traffic light icon is yellow. Doing so will render 
the PCM inoperable but recoverable. (See page 81 for recovery strategies) 

 

 

You may interrupt the reflash process whenever the traffic light icon is green. Doing so will 
have no harmful effects on the PCM. 

 

 
You may interrupt the read process at any time. Doing so will have no harmful effect on the 
PCM. A traffic light icon is not displayed during the read process. 
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Reading 

 

Reading your PCM’s flash memory is simple, safe and fast. Most 512Kb PCM’s can be read in just under 
2 minutes. Normally reading a PCM with 1024Kb of memory would take twice as long as reading a PCM 
with 512Kb of memory. However, with FlashScan’s data compression techniques the read time is under 
three minutes. 

A read operation can be interrupted at any stage without causing any problems. Any data that has been 
read will be discarded. It may take a few seconds for EFILive to respond when you click on the [Stop] 
button, be patient. 

If you are attempting to read a 1999+ V8 PCM, you must select 1999+ V8 PCM from the PCM type drop 
down list box at the top of the window. 

If you are attempting to read a 1998 LS1/LS6 PCM, you must select 1998 LSx V8 PCM from the PCM 
type drop down list box at the top of the window. 

The type of PCM you have selected will be displayed at the bottom of the window. Selecting the wrong 
PCM type will result in EFILive being unable to unlock the PCM, since the 98 and 99+ PCMs use 
different locking strategies. 
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Reflashing a new calibration 

 

Reflashing your PCM’s calibration memory is simple, safe and fast. Most vehicles’ PCMs can be 
reflashed in under 30 seconds. 

You can only program your PCM with calibrations from the same operating system number as the PCM. 
The EFILive Tuning Tool enforces that restriction. If you attempt to reflash an incompatible calibration, 
EFILive will display the following message (probably with different numbers): 

 

 

 
A calibration reflash operation can be interrupted at any stage by clicking on the [Stop] 
button, however, if you do interrupt the reflash sequence while the traffic light icon is 
yellow, the PCM will be left in a state that prevents you from starting or driving your 
vehicle. (See page 81 for recovery strategies) 
 
It may take a few seconds for EFILive to respond when you click on the [Stop] button, be 
patient. 
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Reflashing a new operating system 

Commercial and Workshop versions of EFILive’s Tuning Tool allow you to convert PCMs between 
operating systems using our full-reflash technology. Doing so is potentially hazardous to the PCM and is 
not offered as part of the Personal version. 

 

 

 
An operating system reflash operation must NEVER be interrupted while the red traffic light 
icon is displayed. Doing so may render the PCM unrecoverable. 
 
If the operating system reflash operation is interrupted while the traffic light icon is yellow, 
then the PCM will be left in a state that prevents you from starting or driving your vehicle. 
(See page 81 for recovery strategies) 
 
It may take a few seconds for EFILive to respond when you click on the [Stop] button, be 
patient. 

Prior to actually reflashing your PCM, you may use the [Test] button to simulate the reflash session. The 
simulation will find most potential problems without risk. The simulation is identical in every way to the 
real reflash session, except for a number of important factors: 

1. The PCM’s memory is NOT erased. 
2. All data sent to the PCM for reflashing is discarded by the PCM during the simulation. 
3. Nothing is altered permanently in the PCM. You cannot cause any problems to your PCM using 

the simulation. 
4. The simulation can be interrupted at any stage without causing any problems. 

 

 
Personal and Commercial users: 
You must still license the PCM even if you are only running the simulation, so we advise 
that you only run the simulation on a PCM if you intend to actually reflash it. 
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Once the data transfer is complete, you should switch off your ignition for 15 seconds to return the PCM 
to normal operating conditions. While this may not appear to be necessary, we advise that you do. 
During the read and reflash process EFILive alters the contents of the PCM’s RAM (Random Access 
Memory). To re-initialize the PCM’s RAM to normal operating conditions, requires that you switch off the 
ignition for at least 15 seconds. 

Prior to reflashing the PCM, EFILive automatically calculates a calibration checksum for each segment, 
and one overall checksum for the entire calibration. This means that the PCM can (and does) verify that 
the data sent by EFILive is exactly the same data that is being reflashed into it. 
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Lock PCM 

 

Lock PCM will cause the PCM to be locked at the conclusion of the full reflash, according to the locking 
options selected. See PCM Locking on page 82 for an explanation of the locking options. 

Ignitions cycles before VAT relink: allows you to specify how many ignition cycles must occur before 
the PCM attempts to lock itself to a BCM and secure itself using the seed and key. If a value other than 
zero is specified, then the PCM remains unsecured (i.e. seed/key is disabled) and unlinked (i.e. no BCM 
security link) until the required number of ignition cycles have occurred. In that case, the locking options 
are not available. If the Lock PCM option is checked, then this value cannot be other than zero. 
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CASE 

 

You may elect to preserve the CASE (Crank Angle Sensor Error) learned data during a full reflash. You 
should always preserve the CASE data if the PCM is not being moved between vehicles. The only time 
you should not preserve CASE data is when the PCM will be mated into a different engine than the 
engine on which it has learnt its CASE data. 

This option is a bonus for mail order tunes since the customer is not required to return his vehicle to the 
local dealer in order to have the dealer perform a CASE learn. 
 

 
The EFILive Scan Tool can perform a CASE learn when required. 
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TAP 

 

If you are reflashing an Allison transmission then you may elect to reset the TAP cells at the completion 
of reprogramming. The TAP cells are reset according to the TAP cell presets set in the Allison calibration 
that is being reflashed into the TCM. 
 

 
The EFILive Scan Tool, Allison bidirectional controls, can be used to clear and/or reset the 
TAP cells at any time. 
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Licensing 

If you are using a Personal or Commercial version of the FlashScan interface, you must allocate one of 
your interface cable’s available license slots to the PCM being reflashed. You only need to license a 
PCM the first time you reflash it. After that, FlashScan will reflash that PCM without restriction. 

When you attempt to reflash a PCM for the first time, you will see this message: 

 

If you really want to use one of your available PCM licenses slots to reflash the PCM, then close the 
dialog box and click on the [License PCM] button. EFILive will ask you for confirmation twice more. If 
you accept both challenges, then EFILive will license your FlashScan cable to the PCM. 
 

 
Once you have licensed a PCM to your FlashScan cable, you cannot unlicensed it. 

Once the PCM is licensed, restart by clicking the [Start] or [Test] buttons. 
 

 
You can check your FlashScan cable’s license status using the menu option Help-
>FlashScan Licensing… 
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Recovering 

If a calibration or operating system reflash attempt fails for any reason, then the PCM will be left without 
a full operating system or calibration. The PCM is not physically damaged in any way; it just does not 
have enough calibration information with which to operate the vehicle. The PCM will therefore refuse to 
start or run the engine. 

At the very start of a full operating system reflash, there is a small, 10 second window in which time a 
failure may render the PCM inoperable and unrecoverable. The window of failure is identified by a red 
traffic light icon next to the [stop] button. Never interrupt the reflash process when the traffic light icon is 
red. 

During an operating system reflash test run, the red traffic light icon is displayed, but because the PCM 
is never erased during a test run, you may interrupt it at any stage. 

If a previous reflash process has failed and the PCM is in a recoverable state, the FlashScan interface 
will indicate the fact by flashing the OBD LED rapidly; about four times per second, the USB LED may 
flash as well. EFILive calls this state: Dead Poll. 

When you open the read or reflash windows and the PCM is in Dead Poll, you will see the following 
message: 

 

Click [Ok] then proceed as normal. Click on the [Start] button to reflash the Dead Poll PCM. 

 
EFILive can recover PCMs that have been left in Dead Poll by other tuning tools. Try it and 
see! 

 

 
Although it is possible to read the calibration data from a Dead Poll PCM, the checksums 
will be damaged. EFILive will allow you to view a calibration with damaged checksums but 
will not permit the calibration to be reflashed into a PCM. 
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  PPCCMM  LLOOCCKKIINNGG  AANNDD  SSEECCUURRIITTYY  

Locking a PCM is currently only available to Commercial and Workshop versions of EFILive. Unlocking a 
PCM is available in all versions of EFILive. 

It is very important to understand that if you lock a PCM, no one, not even a GM dealer can read or reflash  
the PCM. If a dealer tries to reflash a locked PCM, it will appear faulty. The dealer will most likely replace it, 
probably at your expense. 
 

 
EFILive gives no guarantee that locking your PCM will prevent unauthorized access. All 
security systems have weaknesses. The PCM security system is no exception. 

 

Background 

The PCM has a seed/key security system very similar to most standard computer systems’ username 
and password combination, with which we are all familiar. The seed is analogous to the username and 
the key is analogous to the password. EFILive has the ability to alter the key (i.e. the password) to any 
value that you specify. 

GM uses a standard key that can be determined by analyzing the seed. If a PCM is secured using GM’s 
standard key, then EFILive indicates that the PCM is unlocked. 
 

 
A lower level of security exists that EFILive calls unsecured. An unsecured PCM has no 
seed/or key securing the PCM at all. Such a PCM is usually a development PCM and you 
are not likely to ever run across one of them “in the wild”. 

A PCM that has been interrupted during a reflash process and therefore has no valid 
calibration or operating system will also be unsecured. 

The seed is not secret; it can be read from any PCM at any time. For your information, EFILive usually 
displays the seed value whenever it is performing security operations. The key is secret and if you do 
not know it, or cannot determine it from the seed (as per GM’s standard key) then you cannot read or 
reflash the PCM. 

The only way to recover from an unknown key is to de-solder the flash chip from the PCM’s main circuit 
board and reflash it using a flash-chip programmer. Which is a job best left to a professional electronics 
engineer. 
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Locking 

Commercial and Workshop versions allow you to change the PCM’s key to any custom key that you 
choose. This is known as locking the PCM. The Personal version does not allow you to lock a PCM. 
 

 
If you decide to change the key in your PCM to prevent access by anybody else, YOU MUST 
REMEMBER THE KEY. If you forget the key, you have effectively locked yourself out of your 
own PCM. 

Whenever you lock a PCM using EFILive, the PCM’s Serial number, Seed and encrypted key are saved 
to a file called My Documents\EFILive\V7\Bins\PCMLocks.ini. If you ever lose your key, EFILive may 
recover it for you if you quote: 

 the PCM serial number 

 the seed 

 the encrypted key 

EFILive offers limited recovery of forgotten keys. Contact EFILive support support@efilive.com if you 
have locked your PCM using EFILive and have forgotten the key. You must satisfy EFILive that you are 
authorized to unlock that PCM. EFILive reserves the right to refuse to provide a decrypted key to 
anybody for any reason whatsoever. 
 

 
Because of the sensitive nature of that file, you must take precautions to secure its 
contents. 

Unless you are the only person with access to your computer, the best security policy is to 
back up the file to a CD or floppy disk whenever it is changed (i.e. whenever you lock, 
unlock or perform a full operating system reflash on any PCM). Then delete it from your 
hard drive. Be careful not to overwrite any previous backups. 

You may even wish to dispense with the recovery feature completely in which case, delete 
the file whenever you lock a PCM. 

 

mailto:support@efilive.com
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Commercial and Workshop versions of EFILive offer two ways to lock a PCM: 

1. You can specify your own custom key. The key may be any decimal number between 1 and 65535 
inclusive (or in hex: $0001 and $FFFF – including the $ symbol). You are responsible for 
remembering the key that you choose. Lose it, and you cannot read nor reflash your PCM again. 
 
OR 

2. You can allow the FlashScan cable to generate a key for you. The key will not be revealed to you, 
and only FlashScan will know the key. FlashScan can generate and remember an unlimited number 
of keys. Because the key is only known to the FlashScan cable that locked the PCM, only that same 
FlashScan cable can unlock the PCM. 
 
Some operations, such as reading, reflashing and VAT re-linking may be performed on a locked 
PCM without unlocking it first. To do that requires that the user knows and provides the secret key to 
allow EFILive access to the PCM. This method of locking excludes that possibility, since the key is 
never revealed to you. 
 
The benefit of this method is that no one knows the key and the only way to unlock the PCM is to 
have physical possession of the cable. If your FlashScan cable is secure then your PCM tune is also 
secure. 

 

 
If your FlashScan cable is lost or damaged and needs to be replaced, EFILive will 
ensure that the replacement cable is capable of unlocking any PCM that you may have 
locked with the original cable. 

Additionally, EFILive can recover the key(s) used to lock your PCM(s). (See Page 83 for 
details) 
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Unlocking 

All versions of EFILive can unlock a PCM, provided that you know the key or have the FlashScan cable 
that was used to lock the PCM. 

If the PCM was locked with a key chosen by FlashScan then make sure you are using exactly the same 
FlashScan cable and then just click [Unlock]. 

If the PCM is secured by a key that you (or someone else) chose, enter that key into the Key field, then 
click the [Unlock] button. 

 

Security/VAT relink 

The security system in your vehicle usually requires that the PCM and the BCM (Body Control Module) 
negotiate a number of electronic messages until they both agree that the cranking attempt is legitimate. 
To facilitate these negotiations, the PCM and BCM must be linked with a “trusted” connection. This 
prevents bypassing the security system by simply replacing one or both of them with a compromised 
unit. 

If you ever replace your PCM or BCM, then you must re-establish the trusted link between the PCM and 
the BCM. EFILive can do that via the VAT re-link process. 

When you click on the [VAT relink] button, EFILive instructs the PCM to set a flag that will cause it to re-
link to any BCM (that it can “see”) when the ignition is next switched on. 

The procedure is this: 

1. Click on the [VAT relink] button. If the PCM enters re-link mode you will see the following 
message. If you see an error message instead, please contact EFILive support at 
support@efilive.com. 
 

 
 

2. Switch off the ignition. 
 

3. If the BCM to which you want to link is already wired into the vehicle, just switch the ignition back 
on and the PCM will re-link to the BCM. 
 
If the BCM to which you want to link is in a different vehicle, then disconnect the PCM from the 
current vehicle (or bench harness) and connect it to the vehicle with the target BCM. Then switch 
on the ignition. 

If the vehicle does not have a BCM (i.e. you may be transplanting the engine into an older chasis) then you 
should switch off the security system by setting calibration {G1201} Anti Theft Configuration to “None”. 
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Change VIN/BCC 

You can reprogram the VIN and the BCC of the connected PCM. 

Enter the new VIN and/or BCC and click on the two buttons to program the new values into the PCM. 
You must switch off ignition power to the PCM in order for the PCM to permanently store the updated 
values. 
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RROOAADDRRUUNNNNEERR  

The RoadRunner is an LS1-style PCM that has been retrofitted with a Realtime Emulator that allows you to 
make tuning adjustments on the fly while the vehicle is running! No longer will you need to turn the vehicle off 
and take minutes of downtime to modify calibrations. No more crossing your fingers every time you reflash 
the PCM. Changes are instantaneous, and take place through a weatherproof USB cable that can be routed 
into the cab of the vehicle (for driveability and idle tuning), or to a shop cart (for dyno tuning). The vehicle will 
respond to the changes immediately. When you're done tuning, you can save the file and flash it to the 
original PCM. Or you can operate the vehicle continuously from the RoadRunner without any problem. 

Please see http://www.moates.net/roadrunner/ for more information about the RoadRunner. 

 

 
Flash->Roadrunner control panel 

[ ] Display or hide the RoadRunner control panel (or toolbar) 

 
Ctrl+F9 

 

 

[ ] Connect to RoadRunner PCM. 

[ ] Disconnect from RoadRunner PCM. 

[ ] Interrupt a RoadRunner read, program or verify command. 

[ ] Reprogram RoadRunner PCM with ONLY the selected (highlighted) data. 

[ ] Read the operating system and calibration data from the RoadRunner PCM into the EFILive 

Tuning Tool. 

[ ] Reprogram the RoadRunner PCM with just the calibration data from the EFILive Tuning Tool. 

http://www.moates.net/roadrunner/
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[ ] Reprogram the RoadRunner PCM with the calibration data and the operating system from the 

EFILive Tuning Tool (i.e. a full-flash). 

[ ] Compare the currently loaded tuning file with data from the RoadRunner. This option also 

compares both memory banks in the RoadRunner PCM for consistency. 

[ ] Enable or disable real-time updates. When real-time updates are enabled, the RoadRunner 

toolbar status display turns red and the RoadRunner banner displays –Realtime-. 

 

[ ] Swaps PCM control between the RoadRunner’s memory banks and the PCM’s onboard flash 

chip. Using this option may cause incorrect values to be displayed for the VIN and other non-volatile 
information. After setting this option, the PCM should be power cycled to reset it’s internal state. The 
[Emulation] status display will change to [Flash] to indicate that the PCM is operating from its own 
flash memory. 

[ ] Enlarge the RoadRunner toolbar to the full RoadRunner control panel display. 

[ ] Shrink the RoadRunner control panel display to a single toolbar. 
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RRTTAACCSS  

Real Time Automatic Calibration System 

Based on the high performance Roadrunner real-time hardware; RTACS is a natural extension of EFILive's 
tightly integrated Scan/Tune feedback loop. 

RTACS uses feedback from a Wide Band O2 sensor to allow the EFILive software to automatically adjust the 
VE Table (as an example) in real time until the PCM's commanded Air Fuel Ratio's match those measured 
by the Wide Band O2 sensor. 

You may configure RTACS for any calibration table, however it is most useful when used to tune the fuel 
tables, specifically the VE or MAF tables. The example given in this document refers to the VE table but it 
applies equally to the MAF table. 

To configure RTACS for the VE table, you must specify the PID that will be used to generate the feed back. 
Usually it will be one of the wide band O2 AFR PIDs such as {CALC.BEN_LC11}. You must add the PID 
name to the cal_links file as shown by the yellow text below. You should replace the CALC.BEN_LC11 with 
the wide band O2 PID that you are using. 

; Default ROW/COL layout for most LS1 operating systems 

[LS1] 

;Main VE Table 

B0101.ROW=SAE.RPM 

B0101.COL=SAE.MAP 

B0101.RRR=CALC.BEN_LC11 

After modifying the cal_links.txt file you must restart the Tune Tool software to activate the changes. 
 

 
The cal_links.txt file can be found in the \Program Files\EFILive\V7\Configuration folder. 

To activate RTACS a number of pre-requisites must be met: 

1. 1 The RoadRunner PCM must be connected to the Tune Tool software. 
2. The real time update toolbar button must be selected. 
3. The Scan Tool software must be logging data. 

After meeting the above three pre-requisites, you must click on one of the two RTACS toolbar icons 
shown below. 

 

The single headed arrow selects coarse adjustment and may be used to cause large changes early in the 
RTACS process. The four headed arrow selects fine adjustment and should be used later in the RTACS 
process to accurately approach the desired target threshold. 

When using RTACS a number of useful options may be selected to obtain more accurate results: 

 Map Masking 

 RTACS Filters 

 Target Threshold 
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Map Masking 

Map Masking allows the tuner to select cells that are protected from change. Any cell marked as a 
protected cell cannot be changed by RTACS. In fact protected cells cannot be changed under any 
circumstance and the cell protection feature may be used outside of the RTACS system. 

 

By default, protected cells are shown with a white background, but you may change that to any other 
color in the Properties window on the [3D Surfaces] tab page. 

 

RTACS Filters 

It may be necessary to prevent unwanted data being used by RTACS. For example, when tuning the VE 
table it is advisable to ignore all data frames where the throttle position is changing rapidly. EFILive 
provides eight data filters that you may configure to exclude data based on various user-defined 
conditions. 

 

This set of filters was used to dial-in light/part throttle VE table by excluding high throttle transients and 
AFR’s that were less than 13 AFR or greater than 16 AFR. 
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Target Threshold 

The target accuracy threshold may be specified as a percentage. When the RTACS PID is within the 
target threshold the current cell is locked and will not be updated again. 

Changing the Accuracy value will cause all previously locked cells to be unlocked. 

To turn of the target threshold, set the Accuracy to zero. 

 

RTACS Min/Max 

Each time a calibration is opened the RTACS Min and Max values are set to the smallest and largest 
value in the calibration. You may change the Min and Max values but they will always default back again 
when the calibration is re-opened. 

 



EFILive V7 Tuning Tool for GM Vehicles 

support@efilive.com - 92 - www.efilive.com 

FFLLAASSHHSSCCAANN  VV22  LLIICCEENNSSIINNGG  

 

 
FlashScan V2 no longer differentiates between Personal, Commercial and Workshop versions. 
All FlashScan V2 interface cables are designated as either Scan Only or Scan and Tune. All 
Scan and Tune FlashScan interface cables can be licensed with any combination of VIN licenses 
or Stream licenses. 

 

Licensing 

FlashScan Serial is the serial number of your FlashScan interface cable. You must quote that serial 
number when ordering any upgrades from EFILive. 

FlashScan License is the serial number that was copied from your FlashScan V1 interface cable if you 
upgraded from FlashScan V1. Otherwise it is the same as the serial number. 

Firmware version is the version number of the firmware (program) inside your FlashScan cable. 
 

 
Trivia: The firmware inside your FlashScan V2 cable consists of about 20,000 to 40,000 
lines of ‘C’ code, depending on the options available. 

Model is the FlashScan model designation. Currently, all FlashScan V2 cables are designated as FS2. 
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Firmware date is the date when the firmware was last modified. 

Flash counters are the number times this FlashScan interface cable has been used to reflash a PCM. 
These values are for your information only. EFILive does not use it and no restrictions are placed on the 
number of times you may reflash any PCM. 

VIN license counters lists all the license slots in your FlashScan cable. It shows which ones are 
available for use and which ones have been used. Used license slots display the last 9 digits of the serial 
number of the licensed controller. 

You can add more VIN licenses (up to a total of 221) to your FlashScan V2 interface cable. When you 
receive your activation code from EFILive, enter it into the Activation code field and set the License 
number to the number specified with the activation code. Then click on the [Add] button. 

 

VIN Licenses 

You can add more VIN licenses (up to a total of 221) to your FlashScan V2 interface cable. When you 
receive your activation code from EFILive, enter it into the Activation code field and set the License 
number to the number specified with the activation code. Then click on the [Add] button. 

 

Streams 

Streams provide unlimited tuning for a particular controller. Once you have purchased and installed a 
stream, then all vehicles using that controller may be reflashed without restriction. 

You can add Streams to your FlashScan V2 interface cable. When you receive your activation code from 
EFILive, enter it into the Activation code field and set the Stream to the name of the stream that you are 
adding. Then click on the [Add] button. 

 

Upgrading 

If you upgrade from FlashScan Scan Only to FlashScan Scan and Tune, EFILive will send you an 
upgrade code. Enter the upgrade code into the appropriate area on the [Upgrade] tab page. 
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FFLLAASSHHSSCCAANN  VV11  LLIICCEENNSSIINNGG  

 

 

 
FlashScan Workshop interface cables are unrestricted and can be used to reflash any supported 
PCM. Therefore if you have a Workshop cable, you will not see any PCM licenses listed in the 
“Licensed PCMs” column. 

 

Licensing 

FlashScan Serial is the serial number of your FlashScan interface cable. You must quote that serial 
number when ordering any upgrades from EFILive. 

Firmware version is the version number of the firmware (program) inside your FlashScan cable. 
 

 
Trivia: The firmware inside your FlashScan cable consists of about 15,000 lines of ‘C’ 
code. To implement black-box logging, it contains a cut down version of EFILive’s Scan 
Tool. 

Model is the FlashScan model designation. Currently, all FlashScan cables: Personal, Commercial and 
Workshop are designated as FSP. 

Firmware date is the date when the firmware was last modified. 
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FlashScan license controls the feature-set that is available with your FlashScan cable. The license will 
be one of: 

 Scanner 

 Personal Scan&Tune 

 Commercial Scan&Tune 

 Workshop Scan&Tune 

Reflash counter is the number times this FlashScan interface cable has been used to reflash a PCM. 
This value is for your information only. EFILive does not use it and no restrictions are placed on the 
number of times you may reflash any PCM. 

Licensed PCMs lists all the license slots in your FlashScan cable. It shows which ones are available for 
use and which ones have been used. Used license slots display the serial number of the licensed PCM. 

 

PCM Licenses 

You can add more PCM licenses (up to a total of 25) to your Personal FlashScan interface cable. When 
you receive your activation code from EFILive, enter it into the Activation code field and set the License 
number to the number specified with the activation code. Then click on the [Add] button. 

 

Upgrading 

If you upgrade from EFILive Scan Tool Only to EFILive Personal Scan and Tune, EFILive will send you a 
Personal upgrade code. Enter the upgrade code into the appropriate area on the [Upgrade Cable] tab 
page. 

If you upgrade from EFILive Personal Scan and Tune to EFILive Commercial Scan and Tune, EFILive 
will send you a Commercial upgrade code. Enter the upgrade code into the appropriate area on the 
[Upgrade Cable] tab page. 

If you upgrade from EFILive Personal Scan and Tune or EFILive Commercial Scan and Tune, you must 
send the Auth code from the [Authenticate] tab page. That code contains provides proof of the number 
of PCM licenses in the FlashScan cable. EFILive will discount your upgrade to the Workshop version 
depending on the number of PCM licenses that you have added to your FlashScan cable(s). 
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AAPPPPEENNDDIIXX--AA  

GGLLOOSSSSAARRYY  

BCC 
Broadcast Code. 

BCM 
Body Control Module. 

Byte 
Byte is a measure of storage used by digital computer systems. It is a group of 8 bits, and can store one 
value from a set of 256 possible values. The range is from 0 to 255 inclusive. 

Calculated PIDs 
Calculated PIDs are derived from existing PIDs by evaluating user supplied mathematical equations. 

CAN 
Controller Area Network is the new standard for automotive communications protocols. GM will begin 
fully implementing CAN in some of its 2004 models. The Scan Tool will implement the CAN protocol in 
2005. 
The CAN specification is ISO 15765-4. 

Class-2 
GM’s implementation of Class B networking. 

Class A network 
Low speed data link, <10K bits/second. 
Often used for convenience features (entertainment, audio, trip computer, etc.). 
 
Most Class A functions require inexpensive, low-speed communication and typically utilize generic 
UARTs. These functions are proprietary and have not been standardized by the international 
organizations. 

Class B network 
Medium speed data link, (10K bits/second to 125K bits/second). 
Often used for general information transfer (instrument cluster, vehicle speed, legislated emissions data, 
etc.) 
SAE J1850 and ISO 9141-2 are used to implement Class B networks. 

Class C network 
High Speed (125K b/s to 1M b/s or greater). 
 
Often used for real time control (powertrain control, vehicle dynamics, brake by wire, etc.), 
CAN is used to implement class C networks. 

COMx 
Windows serial RS232 communications port x. 

CPU 
Central Processing Unit. This is the hardware chip that controls and processes the information in a 
microcomputer such as a vehicle’s PCM and a Windows PC. 
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DB9 
Describes the shape of the 9 pin serial RS232 connector. 

Drive-by-wire 
A throttle actuation system that is controlled electronically rather than mechanically.  There is no throttle 
cable or direct connection from the accelerator pedal to the throttle blade in this system. 

DTC 
Diagnostic Trouble Code. There are literally thousands of different trouble codes. Whenever a 
malfunction is detected by the PCM, it is usually recorded, and if the fault is emissions related, it will 
illuminate the MIL (or check engine light) on the vehicle’s dashboard. 

ECM 
Engine Control Module. The main computer that controls the engine’s electronic fuel injection system. 

FAQ 
Frequently Asked Questions. 

GM 
General Motors. www.gm.com 

GM-H 
General Motors Holden (Australia). www.holden.com 

Icon  
An icon is a small picture, usually no bigger than 16x16 or 32x32 pixels. It is used as a visual cue for 
some action. Normally you either click or double click an icon to execute the action that it represents. 

ISO 
International Standards Organization. www.iso.org 

LS1 
GM’s identification code for for one of its new GENIII 5.7-liter V8 engines. It was introduced with the 
1997 Corvette.  For the 2001 Corvette application this engine featured 345HP @ 5,600 rpm and (SAE 
net) 350 lb.ft. @ 4400 rpm. 

LS6 
GM’s identification code for one of it’s newer GENIII 5.7-liter V8 engines. It is similar to the LS1, but has 
minor enhancements for additional power.  It was introduced in 2001, for the ZO6 Corvette at  385 @ 
6,000 rpm  385 lb.ft. @ 4,800 rpm.  For the newer Corvettes, performance has been increased to 405HP 
@ 6000 rpm and (SAE net) 400 lb.ft. @ 4800 rpm. 

MHz 
Megahertz (millions of cycles per second). 

Millisecond 
1 millisecond is 1/1000

th
 of 1 second; 500 milliseconds is ½ of 1 second; 1000 milliseconds is 1 second. 

The abbreviation for millisecond is ms. 

OBD 
On Board Diagnostics. 

http://www.gm.com/
http://www.holden.com/
http://www.iso.org/
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OBD I 
On Board Diagnostics level I. 

OBD II 
On Board Diagnostics level II. 

PID/PRN 
Parameter Identifier or Parameter Reference Number. A single unit of information that may be retrieved 
from the ECM/PCM. 

PCM 
Powertrain Control Module. The main computer that controls the engine’s electronic fuel injection system 
AND the electronic automatic transmission. 

Properties 
The properties editor window that can be opened using: 

 
File->Properties 

[ ] Properties 

 
Alt+Enter 

 
PWM 
Pulse Width Modulation. An OBD II protocol used by Ford. The waveform differentiates between binary 
0’s and 1’s by altering the state (active or passive) of each pulse. 

RAM 
Read/write, random access memory used to store constantly changing data. 

Relink 
The process of re-establishing a trusted security link between a vehicle’s PCM and the BCM. 

ROM 
Read only memory, used to store programs and preset information. 

RR 
The RoadRunner PCM is a true real-time calibration addition to EFILive. 
Available from www.moatesware.net. 

RS232 
Serial communications protocol available on most PC’s and laptops. 

RTACS 
EFILive’s exclusive Real Time Automated Calibration System. 

SAE 
Society of Automotive Engineers. www.sae.org 

SAE J1850 
Standard definition of the frame structure for the VPW and PWM communications protocols. 

http://www.sae.org/
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Stoichiometric  
The optimum air to fuel ratio for complete combustion of fuel. This value is different for different fuels. For 
gasoline (petrol) it is defined as 14.7:1, which means 14.7 parts of air to 1 part of fuel is the ideal 
combination for complete combustion. 

USB 
Universal Serial Bus. A new serial protocol that is replacing RS232 on many PCs and laptops. If the 
laptop does not have a serial RS232 connector and is only fitted with USB connectors then you will need 
to use a USB to serial RS232 converter for VIA and AutoTap serial interfaces only. 

VAT 
Vehicle Anti Theft. 

VIN 
Vehicle Identification Number. 

VPW 
Variable Pulse Width is an OBD-II protocol used by GM. The waveform differentiates between binary 0’s 
and 1’s by altering the width (or the length) of each pulse as well as the state (active or passive) of the 
pulse. 

ZIP 
Compressed computer file. www.winzip.com 

http://www.winzip.com/
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AAPPPPEENNDDIIXX--BB  

SSTTOOIICCHHIIOOMMEETTRRYY    

EFILive has the ability to display commanded fuel tables in any one of three units: AFR, EQRatio or 
Lambda. 

 

AFR 

When working with Air Fuel Ratios (AFR), stoichiometry defines the amount of air required to 
completely combust the fuel. For petrol the Stoichiometric value is 14.7. That means it takes 14.7 parts 
of air for each part of fuel in order to burn the fuel completely. Too much air and there will be air 
remaining after all the fuel is combusted (lean), too much fuel and there will be unburnt fuel remaining 
after all the air is consumed (rich). 
 

 
When working with flex-fuel vehicles you should always work in either Lambda or EQRatio 
since the AFR can never be accurately known. 

Just because the theoretical stoichiometric value for fuel and air is 14.7 does not mean the PCM will 
always use 14.7. In fact in most cases it is calibrated to use a value that is close but not quite 14.7 

The stoichiometric value used by the PCM is defined in one of two ways: 

1. As calibration {B3601} 
Or if that calibration is not configured in the PCM (most late models do not have that calibration) 
then 

2. As the constant 14.63 
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EQ Ratio 

EQRatio is a value centered around stoichiometry where 1.00 indicates perfect stoichiometry. Values 
less than 1.00 indicate a lean condition, values greater than 1.00 indicate a rich condition. 

Commanded fuel tables in the PCM are stored natively in EQRatio values. 

Lambda 

Lambda is also a value centered around stoichiometry where 1.00 indicates perfect stoichiometry. 
Values less than 1.00 indicate a rich condition, values greater than 1.00 indicate a lean condition. 

Displaying commanded fuel tables as AFR 

There are two types of commanded fuel tables: 

1. Absolute commanded fuel tables such as {B3618} PE modifier based on RPM. 
and 

2. Modifier commanded fuel tables such as {B3632} Initial Coolant Temp Enrichment. 

Absolute tables 

The absolute commanded fuel tables convert to AFR just fine - all straightforward, simple 
mathematics, so long as EFILive knows the stoichiometric value that the PCM is using. 

EFILive converts from EQRatio to AFR using the following equation: 
AFR = stoichiometry/EQRatio 

Modifier tables 

EQRatio modifier values cannot be accurately converted to AFR. Here's why: 

Say you had an offset of 0.08 EQRatio in {B3632} (Initial ECT enrichment) and lets say that 
stoichiometry is 14.63 as defined by {B3601}. If the currently commanded AFR is stoichiometric, 
then final EQRatio would be 1+0.08 = 1.08 EQRatio. That is an AFR of 14.63/1.08 = 13.5463 AFR, 
which is an AFR offset of -1.0837 AFR 

 

 
If the current commanded fuel is NOT stoichiometric, then the above equation breaks 
down because of the following statement: 
A relative EQRatio’s corresponding relative AFR is proportional to the value to 
which the offset is applied. 

For example: 
An EQRatio of -0.5 applied to an EQRatio of 1.0 yields an EQRatio of: 0.5, which is an AFR, offset of 
29.26-14.63=14.63 AFR from the original 14.63 AFR. An EQRatio of -0.5 applied to an EQRatio of 
1.2 yields an EQRatio of: 0.7, which is an AFR, offset of 20.9-12.19=8.7 AFR from the original 12.19 
AFR. 

So what should go in the EQ Ratio offset tables when they are converted to AFR, +14.63 or +8.7? 
For this reason EFILive does not attempt to convert EQRatio modifiers into AFR or Lambda. 
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 EFILive converts everything using stoichiometry as the reference. The converted AFR values may not 
be absolutely accurate because an off board tool can never know the exact EQRatio to which the 
offsets will be applied when the engine is operating. 

However, the AFR trend is more intuitive to a new user - i.e. which values in the table have smaller AFRs 
and which have larger AFRs. 

A real example: 
Let's say the PCM is currently commanding 13.00 (EQRatio=1.1254) and the ECT modifier calls for 
+0.08 EQRatio and the IAT modifier calls for +0.06 EQRatio. 
The final EQRatio is: 1.1254+0.08+0.06 = 1.2654 EQRatio, which is 11.56156 AFR. 

Now using the values that would be displayed by EFILive: 13.00 + -1.0837 + -0.82811 = 11.0882, which 
is a different AFR but still pointing in the right direction (richer). 

An off board tool can NEVER know that final AFR (or EQRatio) value since it can never know the 
currently commanded EQRatio or AFR value (13.00 in the example above). 

This is one reason why the PCM and most competent PCM tuners do not work in AFR, but in EQRatio or 
Lambda. EFILive provides the AFR display mode in order to ease first time users into the concept of 
EQRatio and/or Lambda. 
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Licensed PCM, 95 
Licensed VIN, 93 
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